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Preface

How to Use This Guide

Purpose of This  The Applied Biosystems AmpF&TR® Sinofiler™ PCR Amplification
Guide Kit User Guide provides information about the Applied Biosystems
instruments, chemistries, and software associated with the
AmpF(STR® Sinofiler™ PCR Amplification Kit.

Pull-Out Chapters This guide is designed to allow users to pull out chapters 2, 3, and 4.
The pull-out chapters have title and back pages, which indicate the
chapter number and title.

Text Conventions  This guide uses the following conventions:

* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

» [talic text indicates new or important words and is also used for
emphasis. For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you
select from a drop-down or shortcut menu. For example:

Select File » Open » Spot Set.

Right-click the sample row, then select View Filter »
View All Runs.

User Attention  Two user attention words appear in Applied Biosystems user
Words documentation. Each word implies a particular level of observation
or action as described below:

Note: — Provides information that may be of interest or help but is
not critical to the use of the product.

IMPORTANT! — Provides information that is necessary for proper
instrument operation, accurate chemistry kit use, or safe use of a
chemical.
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Safety

Safety Alert
Words

Chemical Hazard

Warning

Examples of the user attention words appear below:
Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you
need a valid user ID and password.

Four safety alert words appear in Applied Biosystems user
documentation at points in the document where you need to be aware
of relevant hazards. Each alert word-IMPORTANT, CAUTION,
WARNING, DANGER-implies a particular level of observation or
action, as defined below.

Definitions

IMPORTANT! — Indicates information that is necessary for proper
instrument operation, accurate chemistry kit use, or safe use of a
chemical.

A (O.\I[e]\] — Indicates a potentially hazardous situation that,
if not avoided, may result in minor or moderate injury. It may also be
used to alert against unsafe practices.

A \WLGININed — Indicates a potentially hazardous situation that,

if not avoided, could result in death or serious injury.

—

A prNel35] — Indicates an imminently hazardous situation
that, if not avoided, will result in death or serious injury. This signal
word is to be limited to the most extreme situations.

AWARNING CHEMICAL HAZARD. Some of the chemicals
used with Applied Biosystems instruments and protocols are
potentially hazardous and can cause injury, illness, or death.

vi
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Safety

Chemical Safety  To minimize the hazards of chemicals:

Guidelines * Read and understand the Material Safety Data Sheets (MSDSs)
provided by the chemical manufacturer before you store, handle,
or work with any chemicals or hazardous materials. (See
“About MSDSs” on page vii.)

* Minimize contact with chemicals. Wear appropriate personal
protective equipment when handling chemicals (for example,
safety glasses, gloves, or protective clothing). For additional
safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical
containers open. Use only with adequate ventilation (for
example, fume hood). For additional safety guidelines, consult
the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill
occurs, follow the manufacturer’s cleanup procedures as
recommended in the MSDS.

* Comply with all local, state/provincial, or national laws and
regulations related to chemical storage, handling, and disposal.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets
(MSDSs) with shipments of hazardous chemicals to new customers.
They also provide MSDSs with the first shipment of a hazardous
chemical to a customer after an MSDS has been updated. MSDSs
provide the safety information you need to store, handle, transport,
and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous
chemical, be sure to replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is
MSDSs available to you free 24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then click
MSDS Search.

2. In the Keyword Search field, enter the chemical name, product
name, MSDS part number, or other information that appears in
the MSDS of interest, then click Search.

3. Find the MSDS of interest, click the link or right-click the
MSDS title, then select any of the following:

* Open — To view the MSDS

AmpF&TR® Sinofiler™ PCR Amplification Kit User Guide vii
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Chemical Waste

Hazards

* Print Target — To print the MSDS
+ Save Target As — To download a PDF version of the MSDS

Note: For the MSDSs of chemicals not distributed by Applied
Biosystems, contact the chemical manufacturer.

A o7\ 1{e]] HAZARDOUS WASTE. Refer to Material

Safety Data Sheets and local regulations for handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes

produced by Applied Biosystems instruments are potentially
hazardous and can cause injury, illness, or death.

AWARNING CHEMICAL STORAGE HAZARD. Never

collect or store waste in a glass container because of the risk of
breaking or shattering. Reagent and waste bottles can crack and leak.
Each waste bottle should be secured in a low-density polyethylene
safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

viii
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Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines

Read and understand the Material Safety Data Sheets (MSDSs)
provided by the manufacturers of the chemicals in the waste
container before you store, handle, or dispose of chemical waste.

Provide primary and secondary waste containers. (A primary
waste container holds the immediate waste. A secondary
container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container
storage.)

Minimize contact with chemicals. Wear appropriate personal
protective equipment when handling chemicals (for example,
safety glasses, gloves, or protective clothing). For additional
safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical
containers open. Use only with adequate ventilation (for
example, fume hood). For additional safety guidelines, consult
the MSDS.

Handle chemical wastes in a fume hood.

After emptying the waste container, seal it with the cap
provided.

Dispose of the contents of the waste tray and waste bottle in
accordance with good laboratory practices and local,
state/provincial, or national environmental and health
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the
instrument, you must:

Characterize (by analysis if necessary) the waste generated by
the particular applications, reagents, and substrates used in your
laboratory.

Ensure the health and safety of all personnel in your laboratory.

Ensure that the instrument waste is stored, transferred,
transported, and disposed of according to all local,
state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require
special handling, and disposal limitations may apply.
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Biological Hazard
Safety

&WARNING BIOHAZARD. Biological samples such as

tissues, body fluids, infectious agents, and blood of humans and other
animals have the potential to transmit infectious diseases. Follow all
applicable local, state/provincial, and/or national regulations. Wear
appropriate protective equipment, which includes but is not limited
to: protective eyewear, face shield, clothing/lab coat, and gloves. All
work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment
devices). Individuals should be trained according to applicable
regulatory and company/institution requirements before working
with potentially infectious materials. Read and follow the applicable
guidelines and/or regulatory requirements in the following:

* U.S. Department of Health and Human Services guidelines
published in Biosafety in Microbiological and Biomedical
Laboratories (stock no. 017-040-00547-4; bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne
Pathogens (29 CFR§1910.1030; www.access.gpo.gov/ nara/cfr/
waisidx_01/ 29cfr1910a_01.html).

* Your company’s/institution’s Biosafety Program protocols for
working with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:

www.cdc.gov
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How to Obtain More Information

How to Obtain More Information

Related To obtain any of the following documents, go to
Documentation www.appliedbiosystems.com, then click the links for
Support » Products & Services Literature.

Part

Document Number
Applied Biosystems 3130/3100x! Genetic Analyzers Using Data Collection Software v3.0 4363787
User Bulletin
Applied Biosystems 3130/3130xI Genetic Analyzers Getting Started Guide 4352715
Applied Biosystems 3130/3130xI Genetic Analyzers Maintenance, Troubleshooting, and 4352716
Reference Guide
Applied Biosystems 3130/3130xI Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems 3130/3130xI Genetic Analyzers AB Navigator Software 4359472
Administrator Guide
ABI Prism® 3100/3100-Avant Data Collection v2.0 User Guide 4347102
ABI PrisM® 3100/3100-Avant Genetic Analyzers Using Data Collection Software v2.0 4350218
User Bulletin
ABI PrisM® 3100 Genetic Analyzer User Manual (Data Collection v1.1) 4315834
ABI PrisM® 3100-Avant Genetic Analyzer User Guide (Data Collection v1.0) 4333549
ABI PrisM® 3100/3100-Avant Genetic Analyzers Protocols for Processing AmpF&TR® 4332345
PCR Amplification Kit PCR Products User Bulletin
ABI Prism® 310 Genetic Analyzer User Guide (Windows NT) 4317588
Installation Procedures and New Features for GeneMapper® ID Software v3.2 User 4352543
Bulletin
GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial 4335523
GeneMapper® ID Software Version 3.1 Human Identification Analysis: User Guide 4338775
Quantifiler® Kits: Quantifiler® Human DNA Quantification Kit and Quantifiler® Y Human 4344790
Male DNA Quantification Kit User’s Manual
GeneMapper® ID Software v3.2.1 Patch User Bulletin 4382255
AmpFSTR® Identifiler® PCR Amplification Kit User’s Manual 4323291
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Note: For additional documentation, see “How to Obtain Support”
on page Xii.

Send Us Your Applied Biosystems welcomes your comments and suggestions for
Comments improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting
comments and suggestions relating to documentation. To order
documents, download PDF files, or for help with a technical
question, go to www.appliedbiosystems.com, then click the link for
Support. See “How to Obtain Support” below).

How to Obtain Support

For the latest services and support information for all locations,
go to www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:
* Access worldwide telephone and fax numbers to contact
Applied Biosystems Technical Support and Sales facilities.
» Search through frequently asked questions (FAQs)
* Submit a question directly to Technical Support

* Order Applied Biosystems user documents, MSDSs, certificates
of analysis, and other related documents

* Download PDF documents
+ Obtain information about customer training
* Download software updates and patches

Xii AmpF&TR® Sinofiler™ PCR Amplification Kit User Guide
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Overview

This chapter covers:

Product OVErview . . ... oottt 1-2
WOTKElow OVEIVIEW . . ..ttt e 1-6
Instrument and Software Overview. . ....................... 1-7
Materials and Equipment . ............... ... .. ... ... ..., 1-9
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Chapter 1 Overview

Product Overview

Purpose

Product
Description

About the
Primers

The AmpF(STR® Sinofiler™ PCR Amplification Kit (Sinofiler kit) is
a short tandem repeat (STR) multiplex assay that amplifies 15
autosomal STR loci (D8S1179, D21S11, D7S820, CSF1PO,
D3S1358, D5S818, D13S317, D16S539, D2S1338, D19S433, vWA,
D12S391, D18S51, D6S1043, FGA) and the sex-determining
marker, amelogenin, in a single PCR reaction.

The Sinofiler kit contains all the necessary reagents for the
amplification of human genomic DNA.

The reagents are designed for use with the following
Applied Biosystems instruments:

* Applied Biosystems 3130/3130x/ Genetic Analyzer

+ ABI PrisM® 3100/3100-4vant Genetic Analyzer

+ ABI PrisM® 310 Genetic Analyzer

+ GeneAmp® PCR System 9600

+ Silver 96-Well GeneAmp® PCR System 9700

+ Gold-plated silver block GeneAmp® PCR System 9700

The AmpF(STR® Sinofiler™ kit employs the same primer sequences
as used in the previous AmpF{STR® kits with the exception of
D6S1043 and D12S391. Degenerate primers for the loci D8S1179,
vWA, and D16S539 were added to the AmpF(STR® Sinofiler™
Primer Set to address mutations in the primer binding sites. The
addition of the degenerate primers allows for the amplification of
those alleles in samples containing the mutations without altering the
overall performance of the AmpF{STR Sinofiler PCR Amplification
Kit.

Non-nucleotide linkers are used in primer synthesis for the following
loci: CSF1PO, D5S818, D13S317, D16S539, D2S1338, D12S391,
D18S51, amelogenin, and D6S1043. For these primers, non-
nucleotide linkers are placed between the primers and the fluorescent
dye during oligonucleotide synthesis (Butler 2005, Grossman et al.,
1994, and Baron et al., 1996). Non-nucleotide linkers enable
reproducible positioning of the alleles to facilitate inter-locus
spacing. The combination of a five-dye fluorescent system and the
inclusion of non-nucleotide linkers allows for simultaneous
amplification and efficient separation of the 15 STR loci and
amelogenin during automated DNA fragment analysis.

1-2
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Product Overview

Loci Amplified by
the Kit

Table 1-1 shows the loci amplified, their chromosomal locations, and
the corresponding fluorescent marker dyes. The AmpF(STR®

Sinofiler"™ Allelic Ladder is used to genotype the analyzed samples.
The alleles contained in the allelic ladder, and the genotype of the
Control DNA 9947A are also listed in the table.

Table 1-1 AmpF(STR® Sinofiler™ PCR Amplification Kit loci and alleles
Locus Chromosome Alleles Included in Sinofiler Dve Label Control
Designation Location Allelic Ladder y DNA 9947A
D8S1179 8 8,910, 11,12, 13, 14, 15, 16, 6-FAM™ 13
17,18, 19
D21S11 21g11.2-g21 24,242, 25, 26,27, 28, 28.2, 29, 30
29.2, 30, 30.2, 31, 31.2, 32,
32.2, 33, 33.2, 34, 34.2, 35,
35.2, 36, 37, 38
D7S820 7q11.21-22 6,7,8,9,10,11,12,13, 14,15 10, 11
CSF1PO 5033.3-34 6,7,8,9,10,11, 12,13, 14, 15 10,12
D3S1358 3p 12,13, 14, 15,16, 17, 18, 19 VIC® 14,15
D5S818 5g921-31 7,8,9,10,11, 12,13, 14, 15, 16 11
D13S317 13g22-31 8,9,10, 11, 12,13, 14, 15 11
D16S539 16924-qter 5,8,9, 10, 11,12,13, 14, 15 11,12
D2S1338 2g35-37.1 15,16, 17,18, 19, 20, 21, 22, 23, 19, 23
24,25, 26, 27, 28
D19S433 19q12-13.1 9,10,11,12,12.2,13,13.2, 14, | NED™ 14,15
14.2,15,15.2, 16, 16.2, 17, 17.2
vWA 12p12-pter 11,12, 13, 14,15,16, 17,18, 19, 17,18
20, 21, 22, 23, 24
D12S391 12p13.2 14,15, 16, 17,18, 19, 19.3, 20, 18, 20
21, 22, 23, 24, 25, 26, 27
D18S51 18qg21.3 7,9,10,10.2, 11,12, 13, 13.2, 15,19
14,14.2,15, 16,17, 18, 19, 20,
21, 22, 23, 24, 25, 26, 27
AmpF&TR® Sinofiler™ PCR Amplification Kit User Guide 1-3
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Table 1-1  AmpF(STR® Sinofiler™ PCR Amplification Kit loci and alleles (continued)

Locus Chromosome Alleles Included in Sinofiler Dve Label Control
Designation Location Allelic Ladder v DNA 9947A
Amelogenin X: p22.1-22.3 X, Y PET® X
Y:p11.2
D6S1043 6q16.1 9,10, 11,12, 13, 14, 15, 16, 17, 12, 18
18, 19, 20, 21, 21.3, 22, 23, 24,
25
FGA 4928 17,18,19, 20, 21, 22, 23, 24, 25, 23,24
26, 26.2, 27, 28, 29, 30, 30.2,
31.2,32.2,33.2,42.2,43.2,
44.2,45.2,46.2,47.2,48.2,
50.2,51.2
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Product Overview

Allelic Ladder

Figure 1-1 shows the allelic ladder for the AmpF(STR® Sinofiler™
kit. See “Allelic Ladder Requirements” on page 3-2 for information
on ensuring accurate genotyping.
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Figure 1-1 GeneMapper® ID Software plot of the AmpF(STR®
Sinofiler™ Allelic Ladder
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Workflow Overview

Extract and Quantify DNA

i/

Quantifiler® Total Human DNA Quantification Kit

L

PCR Amplify DNA

AmpF(STR®
Sinofiler™ PCR
Amplification Kit

=

=== =

g% /L2 /

GeneAmp® PCR System GeneAmp® PCR System
9600 Thermal Cycler 9700 Thermal Cycler

Perform Electrophoresis

= LR ) = )

ABI PRISM® ABI PRISM® Applied Biosystems
310 Genetic Analyzer  3100/3100-Avant 3130/3130x/
Genetic Analyzer Genetic Analyzer

Analyze Data

GeneMapper® ID Software
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Instrument and Software Overview

Data Collection
and Analysis
Software

Instrument and
Software
Compatibility

About
Multicomponent
Analysis

This section provides information about the data collection and
analysis software versions required to run the AmpF(STR®
Sinofiler™ PCR Amplification Kit on specific instruments.

The data collection software provides instructions to firmware
running on the instrument and displays instrument status and raw
data in real time. As the instrument measures sample fluorescence
with its detection system, the data collection software collects the
data and stores it. The data collection software stores information
about each sample in a sample file (.fsa), which is then analyzed by
the analysis software.

Operating Data
Instrument System Collection Analysis Software
y Software
3130/3130x/* | Windows XP 3.0 GeneMapper® ID
v3.2.1 and later
3100/3100- Windows NT® 1.1 (3100) GeneMapper ID v3.2.1
Avant 1.0 (3100- and later
Avant)
Windows 2000 2.0 GeneMapper ID v3.2.1
and later
310 Windows XP 3.1 GeneMapper ID v3.2.1
and later
Windows NT 3.0 GeneMapper ID v3.2.1
and and later
Windows 2000

T Applied Biosystems conducted validation studies for the Sinofiler kit using
these configurations.

Applied Biosystems fluorescent multi-color dye technology allows
the analysis of multiple loci, including loci that have alleles with
overlapping size ranges. Alleles for overlapping loci are
distinguished by labeling locus-specific primers with different

colored dyes.

AmpF&TR® Sinofiler™ PCR Amplification Kit User Guide
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How
Multicomponent
Analysis Works

Multicomponent analysis is the process that separates the five
different fluorescent dye colors into distinct spectral components.
The four dyes used in the AmpF{STR Sinofiler PCR Amplification
Kit to label samples are 6-FAM™, VIC®, NED™, and PET®dyes. The
fifth dye, LIZ®, is used to label the GeneScan™ 500 LIZ® Size
Standard.

Each of these fluorescent dyes emits its maximum fluorescence at a
different wavelength. During data collection on the Applied
Biosystems and ABI PRISM® instruments, the fluorescence signals
are separated by a diffraction grating according to their wavelengths
and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM dye emits at the shortest
wavelength and is displayed as blue, followed by the VIC dye (green),
NED dye (yellow), PET dye (red), and LIZ dye (orange).

Although each of these dyes emits its maximum fluorescence at a
different wavelength, there is some overlap in the emission spectra
between the dyes (Figure 1-2). The goal of multicomponent analysis
is to correct for spectral overlap.

Dyes

6-FAM VIC NED PET LIZ
c 100 | | | | |
Rel E
8 80 -
e -
w 60 4
'8 i
N 40 -
© 4
g 20 1 \
o i

T T T T T T T T T T T T 1 T T T T T T

500 550 600 650 700

Wavelength (nm)

Figure 1-2 Emission spectra of the five dyes used in the
AmpF(STR® Sinofiler™ PCR Amplification Kit
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Materials and Equipment

Kit Contents The AmpF(STR®™ Sinofiler™ kit contains sufficient quantities of the
following reagents and the appropriate licenses to perform 200 25-uL

Kit Storage
and Stability

amplifications:

Component Description Volume
AmpF(STR® PCR | Two tubes containing MgCl,, 1.1 mL/tube
Reaction Mix deoxynucleotide triphosphates, and

bovine serum albumin in buffer with

0.05% sodium azide
AmpF(STR® Two tubes containing fluorescently- 0.55
Sinofiler™ Primer | labeled primers and non-labeled mL/tube
Set primers
AmpF(STR® One tube containing 0.10 ng/uL 0.3mL
Control DNA human female cell line DNA in
9947A 0.05% sodium azide and buffer

(refer to pages 1-3 and 1-4 for

profile)
AmpF(STR® One tube of AMpF(STR® Sinofiler™ | 50 uL
Sinofiler™ Allelic Allelic Ladder containing amplified
Ladder alleles. See Table 1-1 on pages 1-3

and 1-4 for a list of alleles included

in the allelic ladder
AmpliTagq Gold® Two tubes of enzyme with an activity | 50 uL/tube
DNA Polymerase of 5 U/uL

The table below lists the storage temperature for the kit components.

The fluorescent dyes attached to the primers are light-sensitive. Protect the
AmpFL’STR® Sinofiler" Primer Set from light when not in use. Amplified
DNA, AmpF(STR® Sinofiler™ Allelic Ladder, and GeneScan'" 500 LIZ® Size
Standard should also be protected from light.

Component

Storage Temperature

AmpF(STR® PCR Reaction Mix

AmpF(STR® Control DNA 9947A

AmpF(STR® Sinofiler™ Allelic Ladder

—20 °C on receipt,
2 to 8 °C after initial use

AmpliTaq Gold DNA Polymerase

AmpF(STR® Sinofiler™ Primer Set

-15t0-25°C

AmpF&TR® Sinofiler™ PCR Amplification Kit User Guide
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Standards for For the Sinofiler kit, the panel of standards needed for PCR
Samples amplification, PCR product sizing, and genotyping are:

» Control DNA 9947A — A positive control for evaluating the

efficiency of the amplification step and STR genotyping using
the AmpF{STR Sinofiler Allelic Ladder.

GeneScan™ 500 LIZ® Size Standard — Used for obtaining
sizing results. It contains 16 single-stranded fragments of 35, 50,
75, 100, 139, 150, 160, 200, 250, 300, 340, 350, 400, 450, 490,
and 500 nucleotides. This standard, which has been evaluated as
an internal lane size standard, yields precise sizing results for
AmpF(STR Sinofiler PCR products. Order the GeneScan 500
LIZ Size Standard (PN 4322682) separately.

AmpF(STR® Sinofiler'™ Allelic Ladder — Developed by
Applied Biosystems for accurate characterization of the alleles
amplified by the Sinofiler kit. The AmpF{STR Sinofiler Allelic
Ladder contains most alleles reported for the 15 autosomal loci.
Refer to “Loci Amplified by the Kit” on page 1-3 for a list of the
alleles included in the Sinofiler kit.

Equipment and  Tables 1-2 and 1-3 list required and optional equipment and materials
Materials Not not supplied with the Sinofiler kit. Unless otherwise noted, many of
Included the items are available from major laboratory suppliers (MLS).

Table 1-2 Equipment

Equipment

Source

Applied Biosystems 3130/3100x/ Genetic Analyzer

ABI Prism® 3100/3100-Avant Genetic Analyzer

ABI PrisM® 310 Genetic Analyzer

Contact your local
Applied Biosystems
sales representative

GeneAmp® PCR System 9700 with the Silver 96-Well block N8050001
GeneAmp® PCR System 9700 with the Gold-plated silver block 4314878
Silver 96-Well sample block N8050251
Gold-plated Silver 96-Well sample block 4314443

Tabletop centrifuge with 96-well plate adapters (optional)

Major Laboratory
Supplier (MLS)
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Materials and Equipment

Table 1-3 User-supplied materials*

Item Source
AmpF(STR® Sinofiler™ PCR Amplification Kit 4382306
3130/3100x/ Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3130x//3100 Genetic Analyzer Capillary Array, 36-cm 4315931
3130/3100-Avant Genetic Analyzer Capillary Array, 36-cm 4333464
POP-4™ Polymer for 3130/3130x/ Genetic Analyzers 4352755
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Hi-Di™ Formamide 4311320
For a complete list of parts and accessories for the 3130/3130x/ instrument, refer to Appendix A of the
Applied Biosystems 3130/3130x! Genetic Analyzers Maintenance, Troubleshooting, and Reference
Guide (PN 4352716).
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Table 1-3 User-supplied materials* (continued)

Item Source
3100/3100-Avant Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3130x//3100 Genetic Analyzer Capillary Array, 36-cm 4315931
3130/3100-Avant Genetic Analyzer Capillary Array, 36-cm 4333464
POP-4™ Polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp™ Optical 96-Well Reaction Plate N8010560
250-uL Glass Syringe (array-fill syringe) 4304470
5.0-mL Glass Syringe (polymer-reserve syringe) 628-3731

For a complete list of parts and accessories for the 3100/3100-Avant instrument, refer to Appendix B
of the ABI PrisM® 3100 Genetic Analyzer and 3100-Avant Genetic Analyzer User Reference Guide
(PN 4335393).

310 Analyzer materials

310 Genetic Analyzer Capillary, 47-cm 402839
0.5-mL Sample Tray 5572
96-Well Tray Adapter (for 9700 thermal cycler trays) 4305051
GeneScan™ 500 LIZ® Size Standard 4322682
Running Buffer, 10X 402824
Genetic Analyzer Septa Retainer Clips for 96-Tube Sample Tray 402866
Genetic Analysis Sample Tubes (0.5-mL) 401957
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Materials and Equipment

Table 1-3 User-supplied materials* (continued)

Item Source
Septa for 0.5-mL Sample Tubes 401956
DS-33 Matrix Standard Set [BFAM™, VIC®, NED™, PET®, and LIZ® dyes] for 4318159
ABI Prism® 310/377 systems
MicroAmp™ 8-Tube Strip, 0.2-mL N8010580
MicroAmp™ 96-Well Base (holds 0.2-mL reaction tubes) N8010531
MicroAmp™ 96-Well Full Plate Cover N8010550
MicroAmp™ 96-Well Tray/Retainer Set 403081
POP-4™ Polymer for the 310 Genetic Analyzer 402838

ABI PrisM® 310 Genetic Analyzer User Guide (PN 4317588).

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the

PCR Amopilification

MicroAmp™ 96-Well Tray N8010541
MicroAmp® Reaction Tube with Cap, 0.2-mL N8010540
MicroAmp™ 8-Tube Strip, 0.2-mL N8010580
MicroAmp™ 8-Caps Strip N8010535
MicroAmp™ 96-Well Tray/Retainer Set 403081
MicroAmp™ 96-Well Base N8010531
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
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Table 1-3 User-supplied materials* (continued)

Item Source
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCL, pH 8.0 MLS
0.5-M EDTA MLS
Vortex MLS

I For the Material Safety Data Sheet (MSDS) of any chemical not distributed by Applied Biosystems,
contact the chemical manufacturer. Before handling any chemicals, refer to the MSDS provided by the
manufacturer, and observe all relevant precautions.
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PCR Amplification

This chapter covers:

PCRWork Areas. .. ...t 2-2
Required User-Supplied Materials and Reagents . . ............ 2-3
Quantifying DNA ... ... ... . 2-4
Preparing the Reactions. .. ............. ... ... ... ..., 2-6
Performing PCR . ... ... .. .. .. .. .. .. 2-8
Amplification Using Bloodstained FTA Cards. ............... 2-9
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Chapter 2 PCR Amplification

PCR Work Areas

PCR Setup Work IMPORTANT! The following items should never leave the PCR Setup
Area Work Area.
» Calculator
* Gloves, disposable
» Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate
clean tube (for Master Mix preparation)

* Microcentrifuge tube rack

 Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettors

» Tube decapper, autoclavable

* Vortex

Amplified DNA IMPORTANT! The following GeneAmp® PCR Systems should never
Work Area leave the Amplified DNA Work Area.
+ Silver 96-Well GeneAmp® PCR System 9700
+ Gold-plated silver block GeneAmp® PCR System 9700
+ GeneAmp® PCR System 9600
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Required User-Supplied Materials and Reagents

Kit Contents and Each AmpF/STR® Sinofiler™ PCR Amplification Kit contains
Storage materials sufficient to perform 200 reactions at a 25-UL reaction
volume. See “Kit Contents” on page 1-9 for details on Sinofiler kit
contents.

IMPORTANT! The fluorescent dyes attached to the primers are light-
sensitive. Protect the primer set from light when not in use.
Amplified DNA, AmpF(STR® Sinofiler™ Allelic Ladder, and
GeneScan'" 500 LIZ® Size Standard should also be protected from
light. Minimize freeze-thaw cycles.

User-Supplied In addition to the Sinofiler kit reagents, the use of low TE buffer
Reagents (10 mM Tris, 0.1 mM EDTA, pH 8.0) is recommended. You can
prepare the buffer as described in the following table or order it from
Teknova (Cat # T0223).

To prepare low TE buffer

1. | Mix together:

* 10 mL of 1 M Tris-HCI, pH 8.0

* 0.2mL of 0.5 M EDTA, pH 8.0

* 990 mL glass-distilled or deionized water

AWARNING CHEMICAL HAZARD. EDTA. Exposure

causes eye irritation. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and
gloves.

Note: Adjust the volumes accordingly for specific needs.

2. Aliquot and autoclave the solutions.

3. Store at room temperature.
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Chapter 2 PCR Amplification

Quantifying DNA

Importance of
Quantitation

Methods for
Quantifying DNA

By quantifying the DNA in a sample, you determine if there is
enough DNA for adequate amplification. You can determine the
smallest volume necessary to obtain 0.50 to 1.25 ng of DNA.
However, the maximum allowable addition of DNA is 10 uL.

If too much DNA is added to the PCR reaction, then the increased
amount of PCR product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for
detection by the instrument (“off-scale” data)

Off-scale data are problematic because:

— Quantitation (peak height and area) for off-scale peaks is not
accurate. For example, an allele peak that is off-scale can
cause the corresponding stutter peak to appear higher in
relative intensity, thus increasing the calculated percent
stutter.

— Multicomponent analysis of off-scale data is not accurate,
resulting in poor spectral separation (“pull-up”).

* Incomplete A nucleotide addition

When the total number of allele copies added to the PCR is extremely
low, allelic dropout can occur, resulting in a partial profile.

Applied Biosystems provides several kits for accurately quantifying
DNA in samples. See the reference cited in Table 2-1 on page 2-5 for
details about these kits.
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Quantifying DNA

Table 2-1 Methods for quantifying DNA

Quantification Kit
(PN 4343906)

Quantifiler® Human
DNA Quantification
Kit

(PN 4343895)

¢ Both Quantifiler® kits have high specificity for
human DNA. The Quantifiler® Y kit is highly specific
for human male DNA.

* The kit detects single-stranded and degraded DNA.
How it works:

The DNA quantification assay combines two 5’
nuclease assays:

e A target-specific (human DNA or human male DNA)
assay, which consists of two primers for amplifying
human or human male DNA and one TagMan® MGB
probe labeled with FAM™ dye for detecting the
amplified sequence

e An internal PCR control (IPC) assay, which consists
of an IPC template DNA (a synthetic sequence not
found in nature), two primers for amplifying the IPC
template DNA, and one TagMan MGB probe labeled
with VIC® dye for detecting the amplified IPC DNA

Product Description References
Quantifiler® Y Properties: Quantifiler® Human
Human Male DNA DNA Quantification

Kits User’s Manual

(PN 4344790)
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Chapter 2 PCR Amplification

Preparing the Reactions

Master Mix

Prepare the master mix by combining AmpF(STR® PCR Reaction
Mix, AmpliTaq Gold® DNA Polymerase, and AmpF(STR®
Sinofiler™ Primer Set reagents.

IMPORTANT! The fluorescent dyes attached to the primers are light-
sensitive. Protect the AmpF{STR® Sinofiler Primer Set from light
when not in use. Also protect the AmpF(STR® Sinofiler Allelic
Ladder, GeneScan™ 500 LIZ® Size Standard, and amplified,
fluorescently-labeled PCR products from light.

To prepare the master mix

L.

Determine the total number of samples, including controls.

IMPORTANT! Vortex the following reagents for 5 sec:

e AmpF(STR® PCR Reaction Mix
e AmpliTag Gold DNA Polymerase
¢ AmpF(STR® Sinofiler Primer Set

AWARNING CHEMICAL HAZARD. AmpliTaq Gold DNA

Polymerase may cause eye and skin irritation. It may cause
discomfort if swallowed or inhaled. Read the MSDS, and follow the
handling instructions. Wear appropriate protective eye wear,
clothing, and gloves.

Spin the tubes briefly in a microcentrifuge to remove any liquid
from the caps.

Select a clean, unused tube for the master mix.

If you are preparing... Then use a...

84 samples and controls 1.5-mL microcentrifuge tube

85-110 samples and controls | 2.0-mL microcentrifuge tube

>110 samples and controls Tube that is appropriate

2-6
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To prepare the master mix (continued)

Preparing
Sinofiler Kit
Reactions

5.

Calculate the required amount of components as shown:

Note: The formulation in the list below provides a slight overfill to
allow for volume lost in pipetting.

Number of samples X 10.5 uL of AmpF{STR® PCR Reaction Mix
Number of samples X 0.5 uL of AmpliTag Gold DNA Polymerase
Number of samples X 5.5 uL of AmpF{STR® Sinofiler Primer Set

Dispense the appropriate volume of each of the components from
step 5 into a microcentrifuge tube.

Vortex the master mix at medium speed for 3 sec, then centrifuge
the tube or plate briefly before opening the tubes.

Dispense 15 uL of master mix into each reaction tube or plate well.

Prepare the DNA samples:

DNA Sample To Prepare...

Negative Control Add 10 pL of low TE buffer to the
reaction tube or plate well.

Your Sample Dilute a portion of your DNA sample with
low TE buffer so that 0.50-1.25 ng of
total DNA is in a final volume of 10 pL.
Add your sample to the reaction tube or
plate well.

Positive Control Add 10 pL of control DNA 9947A
(0.1 ng/uL) to the reaction tube or plate
well.

Note: The final reaction volume should be 25 L.

Centrifuge the plate at 3,000 rpm for about 20 seconds in a
tabletop centrifuge with plate holders to remove bubbles.

Amplify the DNA in a GeneAmp® PCR System 9600 or a Silver 96-
Well GeneAmp® PCR System 9700, or a Gold-plated silver block
GeneAmp® PCR System 9700.
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Performing PCR

To run PCR

1. | Program the thermal cycling conditions.

IMPORTANT! If using the Gold-plated Silver or Silver
96-Well GeneAmp PCR System 9700, select the 9600 Emulation

Mode.
Initial Cycle Final Final
Incubation (28 cycles) Extension Hold
Step
De- Anneal | Extend
nature
HOLD CYCLE HOLD HOLD
95 °C 94 °C 59 °C 72 °C 60 °C 4°C
11 min 1 min 1 min 1 min 60 min o

2.  Load the plate into the thermal cycler and close the heated cover.

AWARNING PHYSICAL INJURY HAZARD. During

instrument operation, the temperature of the heated cover can be
as high as 108 °C, and the temperature of the sample block can be
as high as 100 °C. Keep hands away from the heated cover and
sample block.

3. | Start the run.

4. | Store the amplified DNA.

If you are storing the DNA for... Store at...
<2 weeks 2t08°C
>2 weeks -15t0-25°C

IMPORTANT! Protect the amplified products from light.
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Amplification Using Bloodstained FTA Cards

Ampilification Using Bloodstained FTA Cards

FTA™-treated DNA collection cards can be useful for the collection,
storage, and processing of biological samples. A small punch of the
bloodstained card can be placed directly into an amplification tube,
purified, and amplified without transferring the evidence. Applied
Biosystems studies have indicated that a 1.2-mm bloodstained punch
contains approximately 5-20 ng DNA. Accordingly, an appropriate
cycle number for this high quantity of DNA is 25 cycles. It is
recommended that each laboratory determine the cycle number based
on individual validation studies.

In the example shown in Figure 2-1, a 1.2-mm punch of a
bloodstained FTA card was purified using three washes with FTA
Purification Reagent and two washes with 1X TE buffer. After
drying at room temperature overnight, the punch was then amplified
directly in the MicroAmp® tube for 25 cycles.

Lo 00 10 120 130 140 130 80 70 18D 180 %00 B0 730 380 240 350 760 W0 30 330 S0 B0 30 33 340

| I{ m

Figure 2-1 AmpF(STR® Sinofiler™ PCR Amplification Kit results
from a 1.2-mm FTA bloodstain punch (25-cycle amplification),
analyzed on the ABI PRisM® 3130x/ Genetic Analyzer.
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Performing Electrophoresis

This chapter covers:

Allelic Ladder Requirements . ............................ 3-2
Setting Up the 3100/3100-Avant or 3130/3130x/ Instrument

for Electrophoresis . ..., 33
Preparing Samples for Electrophoresis on the 3100/3100-Avant

or 3130/3130x/ Instrument .. .......... ... ... 3-4
Setting Up the 310 Instrument for Electrophoresis. ............ 3-6

Preparing Samples for Electrophoresis on the 310 Instrument. . . .3-7
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Chapter 3 Performing Electrophoresis

Allelic Ladder Requirements

To accurately genotype samples, you must run an allelic ladder
sample along with the unknown samples. For samples that are run on
the:

+ ABI PriSM® 310 Genetic Analyzer — Run at least one allelic
ladder for every 10 sample injections.

 ABI PriSM® 3100 or Applied Biosystems 3130 series
instruments — Run at least one allelic ladder per every set of 16
samples.

— Applied Biosystems 3130x/ or ABI PRISM® 3100 —
One ladder per injection; one injection = 16 samples
(15 samples + 1 allelic ladder)

— Applied Biosystems 3130 or ABI PRISM® Avant —
One ladder for every 4 injections; one injection = 4 samples

IMPORTANT! Variation in laboratory temperature can cause changes
in fragment migration speed which can cause sizing variation.
Applied Biosystems recommends the above frequency of allelic
ladder injections, which should account for normal variation in run
speed. However, during internal validation studies, verify the
required allelic ladder injection frequency to ensure accurate
genotyping of all samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same
conditions as the samples because:

+ Size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and
electrophoretic conditions.

+ Slight procedural and reagent variations between single and
multiple capillaries result in greater size variation than that
found between samples injected in the same capillary in a single
run.
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Setting Up the 3100/3100-Avant or 3130/3130x! Instrument for Electrophoresis

Setting Up the 3100/3100-Avant or 3130/3130x/
Instrument for Electrophoresis

Reagents and

Electrophoresis
Setup Software
and Reference

Table 1-3 on page 1-11 lists the required materials not supplied with

Parts the AmpF(STR® Sinofiler™ PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-
sensitive. Protect the primer set from light when not in use.
Amplified DNA, AmpF(STR® Sinofiler™ Allelic Ladder, and
GeneScan"" 500 LIZ® Size Standard should also be protected from
light. Minimize freeze-thaw cycles.

This table lists data collection software and the run modules that you
can use to analyze Sinofiler kit products. For details on the
procedures, refer to the documents listed in the table.

Documents
Operating | Data Collection
System Software Run Module References
Windows |3.0(3130/3130x/ |e HIDFragmentAnalysis36_POP4_1 | Applied Biosystems
XP Analyzer)* e Dye Set G5 3130/3130xI Genetic Analyzers
Using Data Collection Software
v3.0, Protocols for Processing
AmpFSTR® PCR Amplification
Kit PCR Products User Bulletin
(PN 4363787)
Windows |2.0 ¢ HIDFragmentAnalysis36_POP4_1 | ABI PRisM® 3100/3100-Avant
2000 e Dye SetG5 Genetic Analyzers Using Data
Collection Software v2.0,
Protocols for Processing
AmpFSTR® PCR Amplification
Kit PCR Products User Bulletin
(PN 4350218)
Windows | 1.1 (3100 Analyzer) | Run Module: ABI Prism® 3100/3100-Avant
NT® GeneScan36vb_DyeSetG5Module | Genetic Analyzers Protocols for
. . Processing AmpF&TR® PCR
é”sijgzﬁn'\gf’gge's Amplification Kit PCR Products
ysis-gsp User Bulletin (PN 4332345)
1.0 (3100-Avant Run Module:
Analyzer) GeneScan36Avb_DyeSetG5Module
Analysis Module:
GS500Analysis.gsp

T Applied Biosystems conducted validation studies for the Sinofiler kit using this configuration.
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Chapter 3 Performing Electrophoresis

Preparing Samples for Electrophoresis on the
3100/3100-Avant or 3130/3130x/ Instrument

Preparing the Prepare the samples for electrophoresis on the 3100/3100-4vant or
Samples 31 30/3130x/ immediately before loading.

To prepare samples for electrophoresis

1.

Calculate the volume of Hi-Di™ Formamide and GeneScan™
500 LIZ® Internal Size Standard needed to prepare the
samples, using the table below.

Volume
Reagent Per Reaction (uL)
GeneScan™ 500 LIZ® Size Standard 0.3
Hi-Di™ Formamide 8.7

Note: Include additional samples in your calculations to
provide excess volume for the loss that occurs during reagent
transfers.

IMPORTANT! The volume of size standard indicated in the
table is a suggested amount. Determine the appropriate
amount of size standard based on your results/experiments.

AWARNING CHEMICAL HAZARD. Hi-Di

Formamide. Exposure causes eye, skin, and respiratory tract
irritation. It is a possible developmental and birth defect
hazard. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing,
and gloves.

Pipette the required volumes of components into an
appropriately sized polypropylene tube.

Vortex the tube, then centrifuge briefly.

3-4

AmpF&TR® Sinofiler™ PCR Amplification Kit User Guide



Preparing Samples for Electrophoresis on the 3100/3100-Avant or 3130/3130x! Instrument

To prepare samples for electrophoresis (continued)

4. Into each well of a MicroAmp"" Optical 96-Well Reaction
Plate, add:

* 9 uL of the formamide:size-standard mixture
* 1 uL of PCR product or Allelic Ladder

Note: For blank wells, add 10 uL of Hi-Di"" formamide.

5. Seal the reaction plate with appropriate septa, then briefly
centrifuge the plate to ensure that the contents of each well
are mixed and collected at the bottom.

6. Heat the reaction plate in a thermal cycler for 3 minutes at
95 °C.

AWARNING PHYSICAL INJURY HAZARD.

During instrument operation, the temperature of the heated
cover can be as high as 108 °C, and the temperature of the
sample block can be as high as 100 °C. Keep hands away
from the heated cover and sample block.

7. | Immediately place the plate on ice for 3 minutes.

8.  Prepare the plate assembly on the autosampler.

9.  Start the electrophoresis run.
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Setting Up the 310 Instrument for Electrophoresis

Reagents and
Parts

Table 1-3 on page 1-11 lists the required materials not supplied with
the AmpF(STR® Sinofiler™ PCR Amplification Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-
sensitive. Protect the primer set from light when not in use.
Amplified DNA, AmpF(STR® Sinofiler™ Allelic Ladder, and
GeneScan'" 500 LIZ® Size Standard should also be protected from
light. Minimize freeze-thaw cycles.

Electrophoresis
Setup Software
and Reference
Documents

The following table lists data collection software and the run modules
that you can use to analyze Sinofiler kit products. For details on the
analysis procedures, refer to the documents listed in the table.

Data
Collection
Software

Operating

System Run Module

References

Windows XP 3.1% GS STR POP4 (1 mL) G5 v2.md5 | ABI PRisM® 310 Genetic Analyzer
User’s Manual (Windows)

(PN 4317588)

ABI Prism® 310 Protocols for
Processing AmpF&TR® PCR
Amplification Kit Products with
Microsoft Windows NT Operating
System: User Bulletin

(PN 4341742)

Windows NT® 3.0

and Windows
2000

GS STR POP4 (1 mL) G5 v2.md5

ABI PrisM® 310 Genetic Analyzer
User’s Manual (Windows)
(PN 4317588)

ABI PrisM® 310 Protocols for
Processing AmpF&TR® PCR
Amplification Kit Products with
Microsoft Windows NT Operating
System: User Bulletin

(PN 4341742)

T Applied Biosystems conducted concordance studies for the Sinofiler kit using this configuration.
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Preparing Samples for Electrophoresis on the 310 Instrument

Preparing Samples for Electrophoresis on the 310
Instrument

Preparing the Prepare the samples for electrophoresis on the 310 instrument
Samples immediately before loading.

To prepare samples for electrophoresis

1. Calculate the volume of Hi-Di"™" Formamide and GeneScan™
500 LIZ® Internal Size Standard needed to prepare the
samples, using the table below.

Volume
Reagent Per Reaction (uL)
GeneScan™ 500 LIZ® Size Standard 0.5
Hi-Di™ Formamide 24.5

Note: Include additional samples in your calculations to
provide excess volume for the loss that occurs during reagent
transfers.

IMPORTANT! The volume of size standard indicated in the
table is a suggested amount. Determine the appropriate
amount of size standard based on your results/experiments.

AWARNING CHEMICAL HAZARD. Hi-Di

Formamide. Exposure causes eye, skin, and respiratory tract
irritation. It is a possible developmental and birth defect
hazard. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing,
and gloves.

2. | Pipette the required volumes of components into an
appropriately sized polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. | Into each 0.2-mL or 0.5-mL sample tube, add:
* 25 uL of the formamide:size standard mixture
* 1.5 uL of PCR product or Allelic Ladder
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Chapter 3 Performing Electrophoresis

To prepare samples for electrophoresis (continued)

5.

Seal the tubes with appropriate septa, then briefly centrifuge
the tubes to ensure that the contents of each tube are mixed
and collected at the bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95 °C.

AWARNING PHYSICAL INJURY HAZARD.

During instrument operation, the temperature of the heated
cover can be as high as 108 °C, and the temperature of the
sample block can be as high as 100 °C. Keep hands away
from the heated cover and sample block.

Immediately place the tubes on ice for 3 minutes.

Place the sample tray on the autosampler.

Start the electrophoresis run.
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Analyzing Data
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Chapter 4 Analyzing Data

Overview of GeneMapper® ID Software

GeneMapper® ID Software is an automated genotyping software for
forensic, paternity, and database data analysis and other genotyping
needs.

After electrophoresis, the data collection software stores information
for each sample in a .fsa file. Using GeneMapper /D v3.2.1 and v3.3
software, you can then analyze and interpret the data from the .fsa
files.

Instruments  Refer to “Instrument and Software Overview” on page 1-7 for a list
of compatible instruments.

Before You Start When using GeneMapper /D Software v3.2.1 and v3.3 to perform
human identification (HID) analysis with AmpF(STR® Kits,
be aware that:

» HID analysis requires at least one allelic ladder sample per run
folder. Your laboratory can use multiple ladder samples in an
analysis, provided individual laboratories conduct the
appropriate validation studies.

For multiple ladder samples, the GeneMapper /D Software
calculates allelic bin offsets by using an average of all ladders
that use the same panel within a run folder.

 Allelic ladder samples in an individual run folder are considered
to be from a single run.
When the software imports multiple run folders into a project,
only the ladder(s) within their respective run folders are used for
calculating allelic bin offsets and subsequent genotyping.

 Allelic ladder samples must be labeled as “Allelic Ladder” in the
Sample Type column in a project. Failure to apply this setting for
ladder samples results in failed analysis.

+ Allelic bin definitions are stored in the AmpF{STR_Sinofiler
panels in the Panel Manager.

» Lanes or injections containing the allelic ladder must be
analyzed with the same analysis method and parameter values
that are used for samples to ensure proper allele calling.
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Alleles that are not in the AmpF(STR® Allelic Ladders do exist.
Off-ladder alleles may contain full and/or partial repeat units.
An off-ladder allele is an allele that occurs outside the +0.5-nt
bin window of any known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, the
sample result needs to be verified according to the laboratory’s
protocol.

Setting Up GeneMapper® ID Software for
Analyzing AmpF(STR® Sinofiler™ Kit Data

Workflow Before you can analyze sample (.fsa) files using GeneMapper ID
Software v3.2.1 or v3.3 for the first time, you need to:

Import panels and bins into the Panel Manager, as explained in
“Importing Panels and Bins (3.2.1 only)” on page 4-4. (This
section does not apply to GeneMapper /D Software v3.3, which
automatically installs panels and bin sets during installation.)

Import an analysis method, as explained in “Importing an HID
Analysis Method (v3.2.1 and v3.3)” on page 4-9.

Import a size standard, as explained in “Importing an HID Size
Standard (v3.2.1 and v3.3)” on page 4-16.

Define custom views of analysis tables (v.3.2.1 and v3.3).

Refer to Chapter 1 of the GeneMapper® ID Sofiware Versions
3.1 and 3.2 Human ldentification Analysis Tutorial
(PN 4335523) for more information.

Define custom views of plots (v.3.2.1 and v3.3).

Refer to Chapter 1 of the GeneMapper® ID Sofiware Versions
3.1 and 3.2 Human ldentification Analysis Tutorial
(PN 4335523) for more information.

If necessary, convert any GeneScan software sample files
generated on the Macintosh® platform to the .fsa format using
the Mac-to-Win AppleScript® software provided with
GeneMapper ID software. Conversion is described in the
GeneMapper® ID Software Version 3.1 Human Identification
Analysis User Guide (PN 4338775).
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For More Info

Importing

Panels and Bins

(3.2.1 only)

For quick set up instructions, refer to the GeneMapper® ID Software
Version 3.3 Getting Started Guide (PN 4385329).

For details about GeneMapper ID features, refer to the GeneMapper®

1D Software Version 3.1 Human Ildentification Analysis User Guide
(PN 4338775) and the GeneMapper® ID Sofiware Versions 3.1 and
3.2 Human Identification Analysis Tutorial (PN 4335523). Also,
refer to the Installation Procedures and New Features for
GeneMapper® ID Software v3.2 User Bulletin (PN 4352543).

To import the Sinofiler kit panels and bin sets from the
Applied Biosystems web site into the GeneMapper /D Software
v3.2.1 database:

To import panels and bin sets

1. | Download and open the file containing panels and bins:

a. Open an internet browser, then download the file
GMID_Sinofiler_files.zip from
www.appliedbiosystems.com/support/download/
GeneMapper/GMID_Sinofiler_files.zip

b. Unzip the file.

2. | Start the GeneMapper ID software, then log in with the
appropriate user name and password.

IMPORTANT! If you need logon instructions, refer to page
2-7 of the GeneMapper® ID Software Version 3.1 Human
Identification Analysis User Guide (PN 4338775).

3. Select Tools » Panel Manager.
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To import panels and bin sets (continued)

4.

Find, then open the folder containing the panels and bins:

a. Select Panel Manager in the navigation pane.

(#] Panel Manager
File Edit Eins “iew
=8 MY N N

B Panel Manager

[} ]
||

Highlight this.
|

b. Select File » Import Panels to open the Import Panels
dialog box.

c. Navigate to, then open the GMID_Sinofiler_files folder
that you unzipped in step 1.

Select AmpFLSTR_Sinofiler_Panels_vl1, then click
Import.

Note: Importing this file creates a new folder in the
navigation pane of the Panel Manager,
AmpFLSTR_Sinofiler_Panels_v1. This folder contains the
panels and associated markers.

(&) Import Panels f'5__<|
Look in: |@ GMID_Sinafiler_files V| I ,_5||E
e E] AmpFLSTR_Sinofiler _Bins _w1
,-J B AmpFLSTR_Sinafiler_Psi
Recent 2] CE_GS_Sinofiler_GS500
7[-:% Sinofiler_HID_1
Desktop
._j File: name: |AmpFLSTR_SinofiIer_PaneIS_v'I bt | Import
Wy Documents | Files of type; |AII Filaz w | Cancel
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To import panels and bin sets (continued)

6. Import AmpFLSTR_Sinofiler_Bins_vl:

a. Select the AmpFLSTR_Sinofiler_Panels_v1 folder in
the navigation pane.

(7] Panel Manager
File Edit EBins Yiew

X O HEE HEME e

B AmpFLETR_Sinafiler_Panels vl
[T sinofiler w1

b. Select File » Import Bin Set to open the Import Bin
Set dialog box.

c. Navigate to, then open the GMID_Sinofiler_files
folder.

d. Select AmpFLSTR_Sinofiler_Bins_v1, then click
Import.

Note: Importing this file associates the bin set with the
panels in the AmpFLSTR_Sinofiler_Panels_v1 folder.

&) Import Bin Set X

Loskin: |C) OMD_Sincfiler_files v 2 2E=E
= E AmpFLSTR_Sinofiler_Bins w1

’j @ AmpFLETR_Sinofiler_Panels_v1

Recert CE_G5_Sinofiler_GS500

T% Sinafiler_HID_y1

Desktop
‘-"/, Filename: | AmpFLSTR_Siafiler_Bins_v1 xt | | troport

My Documerts | FilEs 07 type: |AII Files v | Cancel
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To import panels and bin sets (continued)

7.

View the imported panels in the navigation pane:

a. Double-click the AmpFLSTR_Sinofiler_Panels_v1
folder to view the Sinofiler_v1 folder.

b. Double-click the Sinofiler_v1 folder to display the
panel information in the right pane and the markers

below it.

) Panel Manager
File Edit Bins View

B B EE B M ense |AmpFLSTR_Sian\Ier_B\ns_M v| LN =

=] ﬁ'AmpFLSTR Sinofiler_Panelz_w1

DES1179
L2151
Lyss20
CEF1PO
D351358
DESa18
0138317
165539
D251338
D185433
WA
D125391
D18551
AMEL
DES1043
FGA

~

2

=IReterence Samples

Murer Higne | Dye Color | Min Size | B Sime | Conrol Alleles
1 [paEs1173 hlue 113.0 1785 13
2 |Dsn blue 1821|2451 (30
3 |D7sEz0 blue 2483|2958 [10,11
4 |CSFIPO hlue 30009 (3466 10,12
5 |D351358 green as.0 1456 14,15
& |DasEis green  [1535  |20449 |11
7o|M3s37 green (2045 |24801 |11
& |DMB3539 dreen 2503 29681 11,12
a |D2s1338 green 30249 (36880 19,23
10 0195433 yelow  |96.7 1437 [1415
11 |wie yelow |1485  |210  [1718
12 |D125391 yellowr 2145 27449 18,20
13 |D18551 yellow 27989 |3655 15,19
14 | AMEL red 1073|1153 |x
15 |DES1043 red 186 204 6 12,18
16 |FG& red 20565 (3594 23,24
<
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To import panels and bin sets (continued)

8.

View the markers and display the Bin view in the navigation
pane:

a. Select the Sinofiler_v1 folder to display its list of
markers in the right pane.

b. Double-click the Sinofiler_v1 folder to display its list
of markers below it.

c. Select D12S391 to display the Bin view for the marker
in the right pane.

(7] Panel Manager,
File Edit Bins View

Biox 2 m w8 M Binset: |ampFLSTR_Sinofiler_Bins_1 v| Il
=] ﬁAmpFLSTR_Sinofiler_PaneIs_v1 L
a, bl = Fsinafier_v - T el
DES1179 10

D251
D7sE20

CEFIPO 03
D351358
DSSE18
013537 08
0165539
D251338 07
0195433

Cc— 91 05
D18S51
AMEL
DES1043 — 0.3
FGA 3z

< | = 04

=IReference Samples

03

0z

01

Click Apply, then OK to add the Sinofiler panel and bin set
to the GeneMapper /D database.

IMPORTANT! If you close the Panel Manager without
clicking OK, the panels and bins are not imported into the
GeneMapper /D database.
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Importing an HID  The analysis method for the AmpF(STR® Sinofiler™ PCR
Analysis Method Amplification Kit uses the HID Advanced Mode Peak Detection
(v3.2.1 and v3.3) Algorithm. This analysis method provides users with the same
analysis parameters available in GeneScan® Software v3.7.1 for the
Windows operating system.

Note: The HID Advanced Mode analysis method below makes use
of the AmpFLSTR_Sinofiler_Bins_v1 file described in Table 4-1 on
page 4-12.

Use the following procedure to import the analysis method for the
Sinofiler kit from the folder that you downloaded from the
Applied Biosystems web site, into the GeneMapper /D software
database. Refer to step 1 on page 4-4 for downloading instructions.

Note: Sinofiler HID_v1_33 analysis method is provided as a default
analysis method in GeneMapper ID software v3.3. By following the
above procedure it is possible to manually import additional analysis
methods besides the one supplied with GeneMapper /D software
v3.3.

To import the HID Advanced Mode analysis method into
GeneMapper ID software

1. | Select Tools » GeneMapper Manager to open the
GeneMapper Manager.

2. | Import an analysis method for HID_Advanced:
a. Select the Analysis Methods tab, then click Import.

_5_,' GeneMapper Manager

Projects | Analysis Methods | Table Settings | Plot Settings | Matrices | Size Standards
Marne Last Saved OrwiTIEr Instrurnert Anatysiz Type Description
| ShlaPshot Detfault 2005-03-16 16:00:3 | cemic! ShaPshot Factory Provic

| Filer 2005-03-26 05:25:4 | gmid 3100 HID
< >

Don

b. Navigate to, then open the GMID_Sinofiler_files
folder.
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To import the HID Advanced Mode analysis method into
GeneMapper ID software (continued)

3.

Select Sinofiler_HID_v1, then click Import to import the
Sinofiler_HID_v1 analysis method into the GeneMapper /D
database.

(] Import Analysis Method le
Look in: |@ GMID_Sinofiler_files i~ | I ,3|| El

CE_GS_Sinofiler_GS500

,-J B sinafiler_HID_w1

Recent

F— ’

u% File mame: | Sinofiler _HID_w1 xml | Import
Desktop Files of type: |)(ML Files (* xrl) w | Cancel

To view the settings in the Sinofiler_ HID_v1 analysis
method:

a. Select the Analysis Methods tab.
b. Select Sinofiler_HID_v1 in the Name column, then
click Open.

Table 4-1 on page 4-11 shows the settings for each tab
of the Analysis Method Editor - HID.
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Table 4-1 Sinofiler_HID_v1 Advanced Mode analysis method
settings

Tab Settings

General Name: Sinofiler_HID_v1

Analysis Method Editor - HID

Allele | Peak Detector | Peak Quality | Guality Flags
r&nalysis Method Description

[Marne: Sinofiler _HID_w1

Description: Default Sinofiler HID analysis method version 1.

< il

Instrumerit:

Analysis Type: HID
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Table 4-1 Sinofiler_HID_v1 Advanced Mode analysis method
settings (continued)

Tab Settings

Allele

X

Analysis Method Editor, - HID

General | eak Detector | Peak Quality | Quality Flags
Bin Set: |AmpFLSTR_SinofiIer_BinS_v1 b |
Use marker-specific stutter ratio if available
harker Repeat Type : Tri Tetra Penta Hexa
Cut-off Value oo oo oo 0o
MinusA Ratio 0o oo oo 0o
MinusA, Distance From | 0.0 oo oo oo
To oo oo oo oo
Minuz Stutter Ratio oo oo oo oo
Minus Stutter Distance  From | 00 325 oa uln}
To |00 475 oo 0o
Plus Stutter Ratio nn nn 0.0 0.0
Plus Stutter Distance From |00 oo oo oo
To |00 oo oo 0o
Arnelogenin Cutaff

Range Fitter ... Factory Defaultts

¢ GeneMapper® /D Software v3.2.1 and v3.3 allow you
to specify four types of marker repeat motifs: tri, tetra,
penta, and hexa. You can enter parameter values for
each type of repeat in the appropriate column.

¢ The “Use marker-specific stutter ratio if available”
check box is selected by default. Consequently, the
software applies the stutter ratio filters supplied in the
AmpFLSTR_Sinofiler_Panels_v1 file.

Note: For more information about allele filters, refer to
the GeneMapper® ID Software Version 3.1 Human
Identification Analysis User Guide, Chapter 3

(PN 4338775) and the Installation Procedures and New
Features for GeneMapper® ID Software v3.2 User
Bulletin (PN 4352543).
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Table 4-1

Sinofiler_HID_v1 Advanced Mode analysis method

settings (continued)

Tab

Settings

Peak Detector

IMPORTANT! Laboratories need to perform the
appropriate internal validation studies to determine the
peak amplitude threshold (highlighted in red below) that
allows for reliable interpretation of Sinofiler data.

Analysis Method Editor - HID

General | Alleh Peak Quality | Guality Flags

Peak Detection Algarithm: |Advanced e

Rahges Peak Detection
Analysis Sizing Peak Amplitude Thresholds:
Partial Range Partial Sizes B: |50 R =0
Start Pt | 2500 Start Size:| 75
G: | =0 Q: |50
Stop Pt | 10000 Stop Size:| 450
¥: | =0
Smoothing and Baselining
Min. Peak Half Width: 2 pts
Smoothing () Mone _ 3
@ Light Polynomial Degree:
() Hesrey Peak Window Size: 13 pts
Bazeling Window: =l pts e WSt
Peak Start: 00
rSize Calling Method Peak End: 00
O 2nd Order Least Squares
O 3rd Order Least Squares
O Cubic Spline Interpolation
(%) Local Southern Method
O Global Southern Method

Factory Defaults

The software uses the peak detection parameters to
specify the minimum peak height to limit the number of
detected peaks. Although GeneMapper ID software
displays peaks that fall below the specified amplitude in
electropherograms, the software does not label or
determine the genotype of these peaks.

Note: The analysis range is set by the user based on
the locations of the primer peaks and the size standard
peaks.

Note: For information on peak detection algorithms,
refer to the GeneMapper ID Software v3.1 Human
Identification Analysis User Guide (PN 4338775),
Appendix A, and the Installation Procedures and New
Features for GeneMapper ID Software v3.2 User Bulletin
(PN 4352543).
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Table 4-1 Sinofiler_HID_v1 Advanced Mode analysis method
settings (continued)

Tab Settings
Peak Quality Analysis Method Editor, - HID X
General | Allele | Peak Detecto Guality Flags
Signal lewvel
Homozygous min peak height 2000
Heterozygous min peak height 100.0

Heterozygate balance

Min pesak height ratio

Peak morphology

e peak width (basepairs)
Pull-up pesk

’V Pull-up ratio 0.0s

Allele number

Max expected alleles

Factory Defaults
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Table 4-1 Sinofiler_HID_v1 Advanced Mode analysis method

settings (continued)

sty Flag Setting:

Guiglity weights are between 0 and 1.

Tab Settings
Q:ﬂgyplg%gs Analysis Method) Editor - HID [z]
Th I’esh0|ds General | Allele | Peak Detector | Peak Gualit

Spectral Pull-up
Eroad Peak

Cut of Bin Allele

Cverlap

Control Concardance

Lowy Peak Height

Off-zscale

Peak Height Ratio

= =
w w

P Threshold:

Sizing Guality:

Genatype Guality:

Pass Range:
From | 0735 to1.0
From | 075 to 1.0

Lowy Guality Range:

From 0.0to

From 0.010

025

025

Factory Defaults

Cancel
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Importing an HID
Size Standard
(v3.2.1 and v3.3)

The size standard for the AmpF(STR® Sinofiler™ PCR
Amplification Kit uses the following GS500 peaks in its sizing
algorithm: 75, 100, 139, 150, 160, 200, 300, 350, 400, and 450.

Use the following procedure to import the size standard for the
Sinofiler kit from the folder that you downloaded from the Applied
Biosystems web site, into the GeneMapper /D software database.
Refer to step 1 on page 4-4 for downloading instructions.

Note: CE_G5_Sinofiler_GS500 size standard is provided as a
default size standard in GeneMapper /D software v3.3.

To import an HID Size Standard

1.

Select Tools » GeneMapper Manager to open the
GeneMapper Manager.

Import a size standard:

a. Select the Size Standards tab, then click Import.

[7) GeneMapper Manager

Projects | Analysis Methads | Table Seftings | Plot Settings || Matrices | Size Standards
Matne Last Saved Cwher Type Description
377 _G5_HD_GE500 2006-09-20 14:10:2 | gmid Basic/Sdvanced Factory Provided fal
377_F_HID_GS500 2006-09-20 14:10:2| grmicd Basic/Advancend Factory Provided
CE_G5_HID_G=500 2006-09-20 14:10:2 grmict Basic/Sdvanced Factory Proviced [
CE_F_HID_GS500 2006-09-20 14:10:2 | gmid Basic/Sdvanced Factory Provided &
< 5]

New

b. Navigate to, then open the GMID_Sinofiler_files
folder.

Select CE_GS5_Sinofiler_GS500, then click Import to
import the Sinofiler_HID_v1 analysis method into the
GeneMapper /D database.

(] Import Size Standard Method [XI
Look in: |@ GMID_Sinofiler_files i~ | I ,3|| El

Recent
?"_‘.'
L File name: | cE_G5_sinofiler_55500.m! | |_tmport
Desktop Files of type: |)(ML Files (*xml) v | Cancel
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Analyzing and Editing Sample Files with
GeneMapper® ID Software

Analyzing To analyze a project
a Project
(v3.2.1 and v3.3) 1. In the Project window, select File » Add Samples to
Project, then navigate to the disk or directory containing the
sample files.

2. | Apply analysis settings to the samples in the project.

Parameter Advanced Analysis Method

Sample Type Select the sample type.
Analysis Method (v3.2.1) | Sinofiler_HID_v1
Analysis Method (v3.3) Sinofiler_HID_v1_33

Panel (v3.2.1) AmpFLSTR_Sinofiler_Panels_v1

Panel (v3.3) AmpFLSTR_Sinofiler_Panels_v1_33

Size Standard? CE_G5_Sinofiler_GS5008%,*

Matrix Sellect a matrix for 310 instruments
only.

I For more information about how the Size Caller works, refer to the
ABI Prism® GeneScan® Analysis Software for the Windows NT®
Operating System Overview of the Analysis Parameters and Size
Caller User Bulletin (PN 4335617).

§ The following fragments are defined for the
CE_G5_Sinofiler_GS500 size standard provided with the
AmpF(STR® kits: 75, 100, 139, 150, 160, 200, 300, 350, 400, and
450. For additional information about size standards, refer to the
GeneMapper® ID Software Version 3.1 Human Identification
Analysis User Guide (PN 4338775), Appendix D.

# Neither the 250-nt nor the 340-nt peak are included in the size-
standard definition. These peaks can be used as an indicator of
precision within a run.
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To analyze a project (continued)

3.

Click I (Analyze), enter a name for the project (in the Save
Project dialog box), then click OK to start analysis.

* The status bar displays progress of analysis:

— As a completion bar extending to the right with the
percentage indicated

— With text messages on the left

» The table displays the row of the sample currently being
analyzed in green (or red if analysis failed for the
sample).

* The Genotypes tab becomes available after analysis.

(%) GeneMapper, ID v3.2.1 - *Untitled - gmid Is Logged In
Flo Edt Analysis View Took Help

HEE RS WU EME P& reestns oo Jm B8 =
G Saries |
Ca006-11-08 us [Sample Name__[Sanple Type 560 [sFF [05 [58

o Sarie m me
G Semvie

=Y Semvie
Gy Semvie
Gy Semvie
CEY Semvie
Sarie
U Semvie
oY Semvie
G Semvie
U Semvie
U Semvie o
Cadier il Lo o weport[Softer_H0_v1

e dedededidedediede dededr]

il
o o
ol

S >

3

|

Progress status

Figure 4-1 Project Window before analysis

For more information about any of these tasks, refer to the
GeneMapper® ID Software Version 3.1 Human Identification
Analysis User Guide (PN 4338775).
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Examining and  You can display electropherogram plots from the Samples and
Editing a Project  Genotypes tabs of the Project window to examine the data. These
(v3.2.1 and v3.3) procedures start with the Samples tab of the Project window

(assuming the analysis is complete).

For more information about any of these tasks, refer to:

»  GeneMapper® ID Software Version 3.3 Getting Started Guide
(PN 4385329).

s Installation Procedures and New Features for GeneMapper®™ ID
Software Version v3.2 User Bulletin (PN 4352543)

» GeneMapper® ID Software Version 3.1 Human Identification
Analysis User Guide (PN 4338775)

+ GeneMapper® ID Software Versions 3.1 and 3.2 Human
Identification Analysis Tutorial (PN 4335523)
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Chapter 5 Experiments and Results

Overview

Experiments
Using
AmpF(STR®
Sinofiler™ PCR

Amplification Kit

Importance of
Validation

Experiment
Conditions

This chapter provides results of the developmental validation
experiments performed by Applied Biosystems using the
AmpF(STR® Sinofiler™ PCR Amplification Kit (Sinofiler Kkit).

Validation of a DNA typing procedure for human identification
applications is an evaluation of the procedure’s efficiency, reliability,
and performance characteristics. By challenging the procedure with
samples commonly encountered in forensic and parentage
laboratories, the validation process uncovers attributes and
limitations which are critical for sound data interpretation in
casework (Sparkes, Kimpton, Watson et al., 1996; Sparkes, Kimpton,
Gilbard et al., 1996; Wallin et al., 1998).

Experiments to evaluate the performance of the AmpF(STR®
Sinofiler™ PCR Amplification Kit were performed at

Applied Biosystems. The experiments were performed according to
the DNA Advisory Board (DAB) Quality Assurance Standards,
effective October 1, 1998 (DNA Advisory Board, 1998). The DAB
standards describe the quality assurance requirements that a
laboratory should follow to ensure the quality and integrity of the
data and competency of the laboratory.

Additional validation was performed according to the revised
guidelines from the Scientific Working Group on DNA Analysis
Methods (SWGDAM, July 10, 2003). Based on these guidelines,
Applied Biosystems conducted experiments that comply with
guidelines 1.0 and 2.0 and its associated subsections. This DNA
methodology is not novel. (Moretti et al., 2001; Frank et al., 2001;
Wallin ef al., 2002; and Holt et al., 2000).

This chapter discusses many of the experiments performed by
Applied Biosystems and provides examples of results obtained.
Applied Biosystems chose conditions that produced maximum PCR
product yield and that met reproducible performance standards. It is
our opinion that while these experiments are not exhaustive, they are
appropriate for a manufacturer. Each laboratory using the
AmpF(STR® Sinofiler™ PCR Amplification Kit should perform
internal validation studies.

5-2
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Accuracy, Precision, and Reproducibility

SWGDAM  “Developmental validation is the demonstration of the accuracy,
Guideline 1.2.1 precision, and reproducibility of a procedure by the manufacturer,
technical organization, academic institution, government laboratory,
or other party.”” (SWGDAM, July 2003)

SWGDAM  “The extent to which a given set of measurements of the same sample
Guideline 2.9 agree with their mean and the extent to which these measurements
match the actual values being measured should be determined.”
(SWGDAM, July 2003)

Accuracy Laser-induced fluorescence detection of length polymorphism at
short tandem repeat loci is not a novel methodology (Holt ef al.,
2000; and Wallin et al., 2002). However, accuracy and reproducibility
of AmpF(STR® Sinofiler™ PCR Amplification Kit profiles have
been determined from various sample types. Figures 5-1 illustrates
the size differences that are typically observed between sample
alleles and allelic ladder alleles on the Applied Biosystems 3130x/
Genetic Analyzer with POP-4™ polymer. The x-axis in Figure 5-1 on
page 5-4 represents the nominal nucleotide sizes for the AmpF(STR®
Sinofiler™ Allelic Ladder. The dashed lines parallel to the x-axis
represent the £0.25-nt windows. The y-axis represents the deviation
of each sample allele size from the corresponding allelic ladder allele
size. All sample alleles are within 0.5 nt from a corresponding allele
in the allelic ladder.
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Figure 5-1 Size deviation of 54 samples analyzed on the Applied
Biosystems 3130x/ Genetic Analyzer

Sizing precision allows for determining accurate and reliable
genotypes. Sizing precision was measured on the Applied
Biosystems 3130x/ Genetic Analyzer. The recommended method for
genotyping is to employ a +0.5-nt “window” around the size obtained
for each allele in the AmpF(STR® Sinofiler™ Allelic Ladder.

A £0.5-nt window allows for the detection and correct assignment of
alleles. Any sample allele that sizes outside the specified window
could be:

» An “off-ladder” allele, that is, an allele of a size that is not
represented in the AmpF(STR® Sinofiler™ Allelic Ladder

or

* An allele that corresponds to an allelic ladder allele, but whose
size is just outside a window because of measurement error

5-4
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The measurement error inherent in any sizing method can be defined
by the degree of precision in sizing an allele multiple times. Precision
is measured by calculating the standard deviation in the size values
obtained for an allele that is run in several injections on a capillary
instrument or in several lanes of one gel.

Table 5-1 on page 5-6 shows typical precision results obtained from
five runs (16 capillaries/run) of the AmpF(STR® Sinofiler™ Allelic
Ladder on the Applied Biosystems 3130x/ Genetic Analyzer (36-cm
capillary and POP-4™ polymer). The internal size standard that was
used was GeneScan'" 500 LIZ® Size Standard. The results were
obtained within a set of injections on a single capillary array.

Sample alleles may occasionally size outside of the £0.5-nt window
for a respective allelic ladder allele because of measurement error.
The frequency of such an occurrence is lowest in detection systems
having the smallest standard deviations in sizing. Figure 5-1 on
page 5-4 illustrates the tight clustering of allele sizes obtained on the
Applied Biosystems 3130x/ Genetic Analyzer, where the standard
deviation in sizing is typically less than 0.15 nt. The instance of a
sample allele sizing outside the £0.5-nt window because of
measurement error is relatively rare when the standard deviation in
sizing is approximately 0.15 nt or less (Smith, 1995).

For sample alleles that do not size within a £0.5-nt window, the PCR
product must be rerun to distinguish between a true oft-ladder allele
versus measurement error of a sample allele that corresponds with an
allele in the allelic ladder. Repeat analysis, when necessary, provides
an added level of confidence to the final allele assignment.

The GeneMapper® ID software v3.2.1 and later automatically flag
sample alleles that do not size within the prescribed window around
an allelic ladder allele.

Although the precision within a gel or set of capillary injections is
very good, the determined allele sizes vary between platforms. Cross-
platform sizing differences occur from a number of factors, including
type and concentration of polymer mixture, run temperature, and
electrophoresis conditions. Variations in sizing can also occur
between runs on the same instrument and between runs on different
instruments because of these factors.

Applied Biosystems strongly recommends that the allele sizes
obtained be compared to the sizes obtained for known alleles in the
AmpF(STR® Sinofiler™ Allelic Ladder from the same run and then
be converted to genotypes (as described in “Before You Start” on
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page 4-2). Refer to Table 5-1 for the results of five runs of the
AmpF(STR® Sinofiler™ Allelic Ladder. For more information on
precision and genotyping, see Lazaruk ef al., 1998 and Mansfield

etal., 1998.

In Table 5-1, the mean size for all the alleles in each run (16
capillaries) was calculated. The mean range shown in the table is the
lowest- and highest-mean size values of the five runs. Similarly, the
standard deviation for the allele sizing was calculated for all the

alleles in each run. The standard deviation range shown in Table 5-1
is the lowest and highest standard deviation values of the five runs.

Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
Amelogenin
X 108.2-108.38 0.056-0.076
Y 114.33-114.52 0.047-0.073
CSF1PO
6 304.11-304.52 0.054-0.083
7 308.15-308.56 0.057-0.084
8 312.21-312.6 0.042-0.075
9 316.26-316.64 0.041-0.073
10 320.3-320.66 0.055-0.0768
11 324.34-324.69 0.051-0.077
12 328.37-328.71 0.035-0.078
13 332.42-332.72 0.045-0.072
14 336.45-336.74 0.04-0.073
15 340.47-340.74 0.037-0.081

5-6
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)
Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation

D12S391

8 215.54-215.79 0.05-0.066

9 219.5-219.77 0.054-0.071

10 223.5-223.79 0.047-0.067

11 227.42-227.71 0.045-0.062

12 231.38-231.68 0.046-0.066

13 235.33-235.63 0.042-0.067

14 238.35-238.67 0.053-0.075

15 239.3-239.63 0.054-0.07
D13S317

8 216.67-217.02 0.06-0.07

9 220.64-221.01 0.07-0.087

10 224.64-225.01 0.07-0.095

11 228.63-229.01 0.058-0.087

12 232.7-233.11 0.05-0.08

13 236.6-237 0.074-0.087

14 240.54-240.95 0.067-0.088

15 244.53-244.97 0.063-0.093
D16S539

5 252.29-252.66 0.068-0.085
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
8 264.25-264.65 0.065-0.093
9 268.24-268.66 0.065-0.093
10 272.23-272.65 0.068-0.082
11 276.24-276.65 0.064-0.085
12 280.25-280.67 0.063-0.103
13 284.26-284.68 0.062-0.093
14 288.28-288.7 0.063-0.089
15 292.29-292.72 0.058-0.095
D18S51
7 280.24-280.62 0.066-0.092
9 288.35-288.77 0.061-0.087
10 292.41-292.83 0.066-0.101
10.2 294.41-294.83 0.055-0.099
11 296.49-296.91 0.064-0.099
12 300.56-301 0.053-0.101
13 304.68-305.1 0.056-0.105
13.2 306.7-307.12 0.046-0.112
14 308.79-309.19 0.064-0.101
14.2 310.82-311.23 0.062-0.106
15 312.89-313.31 0.071-0.104
16 317-317.41 0.068-0.105

5-8

AmpF&TR® Sinofiler™ PCR Amplification Kit User Guide




Accuracy, Precision, and Reproducibility

Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation

17 321.11-321.49 0.063-0.111
18 325.2-325.58 0.066-0.104
19 329.29-329.66 0.062-0.11

20 333.4-333.74 0.059-0.11

21 337.49-337.81 0.067-0.107
22 341.65-341.96 0.05-0.09

23 345.63-345.92 0.059-0.091
24 349.7-349.98 0.054-0.086
25 353.65-353.9 0.063-0.086
26 357.6-357.82 0.048-0.082
27 361.54-361.76 0.042-0.073

D19S433

15 101.68-101.76 0.042-0.055
16 105.56-105.64 0.039-0.054
17 109.48-109.54 0.039-0.05

18 113.4-113.47 0.034-0.052
19 115.39-115.44 0.043-0.051
20 117.35-117.4 0.037-0.044
21 119.35-119.41 0.031-0.047
22 121.32-121.36 0.035-0.048
23 123.32-123.37 0.035-0.051
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
24 125.3-125.35 0.027-0.048
25 127.33-127.38 0.031-0.044
26 129.33-129.36 0.035-0.042
27 131.36-131.39 0.033-0.044
28 133.36-133.41 0.04-0.055
D21S11
24 184.54-184.72 0.049-0.069
24.2 186.53-186.71 0.039-0.061
25 188.49-188.67 0.039-0.067
26 192.42-192.59 0.041-0.066
27 196.38-196.54 0.036-0.047
28 200.23-200.39 0.042-0.051
28.2 202.21-202.38 0.036-0.049
29 204.2-204.36 0.042-0.046
29.2 206.24-206.42 0.041-0.049
30 208.21-208.38 0.034-0.053
30.2 210.18-210.37 0.028-0.049
31 212.22-212.38 0.036-0.052
31.2 214.18-214.37 0.042-0.061
32 216.19-216.38 0.037-0.052
32.2 218.17-218.38 0.035-0.055
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)
Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
33 220.18-220.4 0.04-0.057
33.2 222.12-222.34 0.038-0.048
34 224.25-224 .47 0.048-0.058
34.2 226.16-226.39 0.042-0.056
35 228.24-228.47 0.046-0.053
35.2 230.15-230.39 0.04-0.064
36 232.14-232.39 0.044-0.053
37 236.21-236.46 0.043-0.054
38 240.15-240.38 0.049-0.059
D2S51338
15 306.48-306.82 0.042-0.082
16 310.54-310.89 0.05-0.093
17 314.61-314.95 0.049-0.087
18 318.67-318.99 0.052-0.082
19 322.73-323.02 0.049-0.081
20 326.76-327.07 0.047-0.07
21 330.83-331.11 0.038-0.083
22 334.87-335.15 0.05-0.078
23 338.93-339.17 0.051-0.082
24 342.97-343.19 0.049-0.08
25 346.99-347.2 0.047-0.088
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer

Allele Mean Standard Deviation
26 351-351.19 0.044-0.069
27 354.92-355.08 0.044-0.065
28 359.12-359.29 0.052-0.068

D3S1358
12 111.45-111.62 0.047-0.071
13 115.54-115.73 0.051-0.072
14 119.53-119.7 0.044-0.08
15 123.44-123.6 0.056-0.076
16 127.63-127.8 0.047-0.078
17 131.83-132.01 0.042-0.076
18 135.93-136.11 0.047-0.068
19 140.03-140.22 0.045-0.067

D5S818
7 160.14-160.51 0.062-0.097
8 164.11-164.46 0.066-0.123
9 168.05-168.42 0.064-0.111
10 172.01-172.36 0.065-0.113
11 175.91-176.28 0.055-0.111
12 179.81-180.17 0.072-0.11
13 183.68-184.04 0.064-0.103
14 187.55-187.89 0.067-0.108
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
15 191.39-191.73 0.065-0.08
16 195.23-195.55 0.071-0.084
D6S1043
9 126.37-126.61 0.069-0.096
10 130.22-130.47 0.064-0.091
11 134.13-134.38 0.071-0.084
12 138.08-138.33 0.065-0.088
13 142.26-142.55 0.058-0.087
14 146.48-146.79 0.062-0.098
15 150.8-151.12 0.068-0.101
16 154.98-155.34 0.064-0.102
17 159.04-159.44 0.074-0.117
18 163.01-163.42 0.061-0.134
19 166.96-167.36 0.066-0.132
20 170.87-171.28 0.081-0.143
21 174.78-175.19 0.075-0.121
21.3 177.66-178.07 0.073-0.12
22 178.67-179.09 0.078-0.121
23 182.61-183.03 0.082-0.116
24 186.48-186.9 0.074-0.125
25 190.42-190.83 0.077-0.105
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
D7S820
6 255.26-255.68 0.053-0.082
7 259.27-259.71 0.066-0.084
8 263.32-263.74 0.058-0.089
9 267.34-267.79 0.055-0.085
10 271.36-271.82 0.06-0.101
11 275.4-275.86 0.066-0.098
12 279.43-279.9 0.063-0.09
13 283.48-283.95 0.063-0.092
14 287.52-288 0.065-0.098
15 291.57-292.06 0.068-0.106
D8S1179
8 122.88-123.03 0.051-0.065
9 126.94-127.1 0.047-0.06
10 131.05-131.2 0.053-0.071
11 135.17-135.32 0.046-0.072
12 139.37-139.53 0.049-0.071
13 143.95-144.16 0.049-0.067
14 148.43-148.66 0.044-0.067
15 152.8-153.04 0.053-0.07
16 157.05-157.34 0.058-0.086
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
17 161.23-161.53 0.058-0.112
18 165.33-165.64 0.059-0.098
19 169.38-169.71 0.054-0.112
FGA

17 214.44-214.82 0.068-0.094
18 218.47-218.87 0.076-0.101
19 222.5-222.92 0.067-0.099
20 226.53-226.95 0.069-0.102
21 230.57-231 0.084-0.094
22 234.61-235.07 0.067-0.103
23 238.65-239.11 0.074-0.102
24 242.69-243.16 0.073-0.114
25 246.74-247.23 0.078-0.119
26 250.79-251.29 0.079-0.109

26.2 252.8-253.32 0.07-0.121
27 254.8-255.32 0.072-0.114
28 258.85-259.38 0.075-0.118
29 262.92-263.46 0.081-0.117
30 267.01-267.56 0.081-0.119

30.2 268.84-269.39 0.08-0.13

31.2 272.91-273.48 0.081-0.13
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer

Allele Mean Standard Deviation
32.2 276.99-277.56 0.09-0.14
33.2 281.06-281.64 0.079-0.134
42.2 318.17-318.74 0.089-0.141
43.2 322.29-322.85 0.091-0.145
44.2 326.41-326.95 0.083-0.148
45.2 330.53-331.07 0.089-0.136
46.2 334.53-335.06 0.078-0.13
47.2 338.62-339.12 0.084-0.144
48.2 342.77-343.24 0.083-0.147
50.2 350.88-351.3 0.07-0.121
51.2 354.83-355.24 0.074-0.125

VWA

11 154.27-154.51 0.059-0.07
12 158.44-158.7 0.052-0.087
13 162.57-162.84 0.047-0.1

14 166.8-167.09 0.057-0.099
15 170.72-171.01 0.053-0.101
16 174.75-175.04 0.059-0.098
17 178.73-179.02 0.05-0.098
18 182.68-182.96 0.057-0.094
19 186.64-186.9 0.039-0.081
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Table 5-1 Precision results of five runs (16 capillaries/run) of the
AmpF(STR® Sinofiler™ Allelic Ladder (continued)

Applied Biosystems 3130x/ Genetic Analyzer
Allele Mean Standard Deviation
20 190.56-190.84 0.064-0.075
21 194.46-194.71 0.053-0.085
22 198.35-198.59 0.053-0.068
23 202.2-202.45 0.055-0.076
24 206.51-206.79 0.052-0.069
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Extra Peaks in the Electropherogram

Causes of Extra

Peaks

Peaks other than the target alleles may be detected on the
electropherogram. Causes for the appearance of extra peaks include
stutter products, incomplete 3" A nucleotide addition (at the n-1
position), dye artifacts, and mixed DNA samples (see DAB Standard
8.1.2.2).

Stutter Products

A stutter is a well-characterized PCR artifact that refers to the
appearance of a minor peak one repeat unit smaller (or less
frequently, one repeat larger) than the major STR product (Butler,
2005; Mulero et al., 2006). Sequence analysis of stutter products at
tetranucleotide STR loci has revealed that the stutter product is
missing a single tetranucleotide core repeat unit relative to the main
allele (Walsh et al., 1996).

The proportion of the stutter product relative to the main allele
(percent stutter) is measured by dividing the height of the stutter peak
by the height of the main allele peak. Peak heights were measured for
amplified samples (n = 840) at the loci used in the AmpF(STR®
Sinofiler’™ PCR Amplification Kit. All data were generated on the
Applied Biosystems 3130x/ Genetic Analyzer.

Some conclusions from these measurements and observations are:

» For each Sinofiler kit locus, the percent stutter generally
increases with allele length, as shown in Figure 5-2 to Figure 5-5
on pages 5-19 through 5-22.

+ Smaller alleles display a lower level of stutter relative to the
longer alleles within each locus.

» Each allele within a locus displays a percent stutter that is
consistent.

» The highest observed percent stutter for each locus is included
as the filtering step in GeneMapper® ID software v3.2.1 and
later. These values are shown in Table 5-2 on page 5-23. Peaks
in the stutter position that are above the highest observed percent
stutter will not be filtered. Peaks in the stutter position that have
not been filtered and remain labeled can be further evaluated.
For evaluation of mixed samples, see “Mixture Studies” on
page 5-37.
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» The measurement of percent stutter for peaks that are off-scale

may be unusually high.
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Table 5-2 Marker-specific stutter percentages (ratios used in
GeneMapper ID AmpFLSTR_Sinofiler_panels_v1) for Sinofiler Kit

loci

Locus % Stutter
CSF1PO 8.5
D12S391 14.5
D13S317 8
D16S539 10
D18S51 16
D19S433 13.5
D21S11 10
D2S1338 13
D3S1358 11
D5S818 7.5
D6S1043 11
D7S820 10
D8S1179 9.5

FGA 13

VWA 13.5

Addition of 3" A Nucleotide

AmpliTaq Gold® enzyme, like many other DNA polymerases, can
catalyze the addition of a single nucleotide (predominately
adenosine) to the 3" ends of double-stranded PCR products (Clark,
1988; Magnuson et al., 1996). This nontemplate addition results in a
PCR product that is one nucleotide longer than the actual target
sequence. The PCR product with the extra nucleotide is referred to as

the “+A” form.
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The efficiency of +A addition is related to the particular sequence of
the DNA at the 3" end of the PCR product. The Sinofiler kit includes
two main design features that promote maximum +A addition:

» The primer sequences have been optimized to encourage +A
addition.

* The final extension step is 60 °C for 60 min.

The final extension step gives the AmpliTaq Gold® DNA polymerase
additional time to complete +A addition to all double-stranded PCR
products. STR systems (where each allele is represented by two peaks
that are one nucleotide apart) that have not been optimized for +A
addition may have “split peaks.”
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Figure 5-6 Omitting the final extension step results in split peaks
due to incomplete A nucleotide addition. Data are from an
ABI PRrisM® 310 Genetic Analyzer using another AmpF(STR® kit.

Lack of complete +A nucleotide addition may be observed in
Sinofiler kit results when the amount of input DNA is greater than
the recommended protocols, because more time is needed for
AmpliTaq Gold DNA Polymerase to add the +A nucleotide to all
molecules as more PCR product is generated. Amplification of too
much input DNA may also result in off-scale data.
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Artifacts

Artifacts and anomalies are seen in all molecular biological systems.
Artifacts are typically reproducible, and anomalies are
nonreproducible, intermittent occurrences that are not consistently
observed in a system, for example, spikes and baseline noise.
Artifacts have been seen in data produced on genetic analyzers when
using the Sinofiler kit. In amplified samples, artifacts in the non-
calling region may appear in the blue (95-100 nt) dye. Low-level
artifacts in the calling region may appear in the blue (118 nt), green
(97, 120, and 189 nt), and black (95-100, 164 nt) dyes, depending on
the sensitivity of the instrument.

Figure 5-7 on page 5-27 shows examples of baseline noise and
artifacts in an electropherogram while using the Sinofiler kit.
Genotyping may result in the detection of these artifacts as off-ladder
alleles, or “OL Alleles.” You should consider possible noise and
artifacts when interpreting data.
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Figure 5-7 Examples of baseline noise and reproducible artifacts
in data produced on the Applied Biosystems 3130x/ Genetic
Analyzer

Note that a high degree of magnification (y-axis) is used to illustrate
these artifacts.
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Characterization of Loci

SWGDAM
Guideline 2.1

Nature of the

Polymorphisms

Inheritance

“The basic characteristics of a genetic marker must be determined
and documented.” (SWGDAM, July 2003)

This section describes basic characteristics of the 15 loci and the
sex-determining marker, amelogenin that are amplified with the
AmpF(STR® Sinofiler™ PCR Amplification Kit. These loci have
been extensively characterized by other laboratories.

The primers for the amelogenin locus flank a 6-nucleotide deletion
within intron 1 of the X homologue. Amplification results in 107-nt
and 113-nt products from the X and Y chromosomes, respectively.
(Sizes are the actual nucleotide size according to sequencing results,
including 3" A nucleotide addition.) The remaining Sinofiler kit loci
are all tetranucleotide short tandem repeat (STR) loci. The length
differences among alleles of a particular locus result from differences
in the number of 4-nt repeat units.

The loci D6S1043 and D12S391 amplified by the Sinofiler kit are
compound STR markers. The D6S1043 alleles contain repeat unit
sequences (ATCT) and (ATGT) that can differ in number and relative
position within the repeat region. The most common repeat motif
(ATCT) is referred to as the core repeat sequence. The D12S391
locus consists of repetitive basic structures of
(AGAT)(AGAC)(AGAT),. Sequence variations within the repeat
region and allele distributions in these two loci have been reported in
various populations (Chen et al., 1999; Chen et al., 2004; Glock

et al, 1997; Hu et al., 2004; Junge and Madea, 1998; Klintschar
etal, 1998; Li et al., 2004; Liu et al., 2005; Lu et al., 2003; Shin

et al., 2004; Su et al., 2004; Waiyawuth et al., 1998; Wu et al., 2004;
Yu et al., 2003).

All the alleles in the AmpF(STR® Sinofiler™ Allelic Ladder have
been been subjected to sequencing at Applied Biosystems. In
addition, other groups in the scientific community have sequenced
alleles at some of these loci. Among the various sources of sequence
data on the Sinofiler kit loci, there is consensus on the repeat patterns
and structure of the STRs.

The Centre d'Etude du Polymorphisme Humain (CEPH) has
collected DNA from families of Utah Mormon, French Venezuelan,
and Amish descent. These DNA sets have been extensively studied
all over the world and are routinely used to characterize the mode of
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inheritance of various DNA loci. Each family set contains three
generations, generally including four grandparents, two parents, and
several offspring. Consequently, the CEPH family DNA sets are ideal
for studying inheritance patterns (Begovich et al., 1992).

Three CEPH family DNA sets were examined. 1 ng of DNA from
each sample was amplified using the AmpF(STR® Sinofiler"™ kit,
followed by analysis using an Applied Biosystems 3130x/ Genetic
Analyzer. The families examined included #1333 (9 offspring),
#1340 (7 offspring), and #1345 (7 offspring), representing 23 meiotic
divisions.

In family #1340, we observed two parent/offspring pairs with
mutations at locus D8S1179. In family #1333, one mutation was
identified at locus D12S391. The genotypes differed by one repeat
unit between the two generations. These samples were reamplified
using the AmpF(STR® Sinofiler™ and AmpF(STR® Identifiler® kits
to confirm the allele calls. Calculation of a mutation rate based on
these data would be inaccurate due to the small sample size. The
other parent-offspring allele transfers were in accordance with
Mendelian rules, as expected.

Mapping The Sinofiler kit loci have been mapped, and the chromosomal
locations have been published (Nakahori ef al., 1991; Edwards et al.,
1992; Kimpton et al., 1992; Kong et al., 2004; Lareu et al., 1996;
Mills et al., 1992; Sharma and Litt, 1992; Li et al., 1993; Straub
et al., 1993; Barber and Parkin, 1996).
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Species Specificity

SWGDAM
Guideline 2.2

“For techniques designed to type human DNA, the potential to detect

DNA from forensically relevant nonhuman species should be

evaluated.” (SWGDAM, July 2003)

The AmpF(STR® Sinofiler™ PCR Amplification Kit provides the
required specificity for detecting primate alleles. Other species do

not amplify for the loci that are tested.

Nonhuman Studies

Nonhuman DNA may be present in forensic casework samples. The
data from Sinofiler kit experiments on nonhuman DNA sources are
shown in Figure 5-8.
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Figure 5-8 Representative electropherograms from a species-
specificity study including positive and non-template controls

(NTC)
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Figure 5-8 on page 5-30 shows amplification for: control DNA
9947A (1 ng, panel 1), chimpanzee (1 ng, panel 2), pig (10 ng,
panel 3), cat (10 ng, panel 4), microbial DNA pool (equivalent to 10°
copies of Candida albicans, Neisseria gonorrhoeae, E. coli 0157:H7,
Bacillus subtilis, and Lactobacillus rhamnosus, panel 5), and the
negative control (panel 6). The extracted DNA samples were
amplified with the Sinofiler kit and analyzed using the

Applied Biosystems 3130x/ Genetic Analyzer.

» Primates: gorilla, chimpanzee, orangutan, and macaque (1 ng
each)

* Non-primates: mouse, dog, pig, cat, horse, hamster, rat, chicken,
and cow (10 ng each)

* Microorganisms: Candida albicans, Staphylococcus aureus,
Escherichia coli, Neisseria gonorrhoeae, Bacillus subtilis, and
Lactobacillus rhamnosus (equivalent to 10° copies)

All the primate DNA samples amplified, producing fragments within
the 100 to 400 base pair region (Lazaruk, et al., 2001; Wallin, et al.,
1998).

The microorganisms, chicken, cat, hampster, rat, and mouse did not
yield detectable product. Horse, cow, dog, and pig produced a 104-bp
fragment near the amelogenin locus in PET® dye.
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Sensitivity

SWGDAM
Guideline 2.3

Importance of
Quantitation

Effect of DNA
Quantity on
Results

“When appropriate, the range of DNA quantities able to produce
reliable typing results should be determined.” (SWGDAM, July
2003)

The optimal amount of input DNA added to the AmpF{(STR®
Sinofiler™ PCR Amplification Kit should be between 0.50 and
1.25 ng. The DNA sample should be quantitated prior to
amplification using a system such as the Quantifiler® Human DNA
Quantification Kit (PN 4343895). The final DNA concentration
should be 0.05 to 0.125 ng/uL so that 0.50 to 1.25 ng of DNA is
added to the PCR reaction in a volume of 10 uL. If the sample
contains degraded DNA, amplification of additional DNA may be
beneficial. In Figure 5-9 on page 5-33 the control DNA 9947A was
serially diluted from 1 ng to 0.062 ng. Full profiles (27 PCR
products) were consistently obtained at 0.125 ng, but occasional
partial profiles (missing from 1 to 3 alleles) were observed at
0.062 ng.

If too much DNA is added to the PCR reaction, the increased amount
of PCR product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for
detection by the instrument ("off-scale" data)

Off-scale data is a problem because:

— Quantitation (peak height and area) for off-scale peaks is not
accurate. For example, an allele peak that is off-scale can
cause the corresponding stutter peak to appear higher in
relative intensity, thus increasing the calculated percent
stutter.

— Multicomponent analysis of off-scale data is not accurate.
This inaccuracy results in poor spectral separation
("pull-up").

* Incomplete +A nucleotide addition

The sample can be reamplified using less DNA.

When the total number of allele copies added to the PCR is extremely

low, unbalanced amplification of the alleles may occur because of
stochastic fluctuation.
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Individual laboratories may find it useful to determine an appropriate
minimum peak height threshold based on their own results and
instruments using low amounts of input DNA.
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Figure 5-9 Effect of amplifying varying amounts of of control
DNA 9947A and negative control

Note that the y-axis scale is magnified for the lower amounts of
DNA, analyzed using the Applied Biosystems 3130x/ Genetic
Analyzer.
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Stability

SWGDAM
Guideline 2.4

“The ability to obtain results from DNA recovered from biological
samples deposited on various substrates and subjected to various
environmental and chemical insults has been extensively
documented. In most instances, assessment of the effects of these
factors on new forensic DNA procedures is not required. However, if
substrates and/or environmental and/or chemical insults could
potentially affect the analytical process, then the process should be
evaluated using known samples to determine the effects of such
factors.” (SWGDAM, July 2003)

Degraded DNA

As the average size of degraded DNA approaches the size of the
target sequence, the amount of PCR product generated is reduced,
due to the reduced number of intact templates in the size range
necessary for amplification.

Degraded DNA was prepared to examine the potential for
preferential amplification of loci. High-molecular-weight Raji DNA
was sonicated and incubated with increasing doses of DNase I (0 to
6 Units) for 20 minutes (Bender et al. 2004). The DNA was
examined by capillary electrophoresis analysis to determine the
average size of the DNA fragments at each time point.

One ng of degraded DNA was amplified using the AmpF(STR®
Sinofiler PCR Amplification Kit. As the DNA became increasingly
degraded, the larger size loci became undetectable (Figure 5-10 on
page 5-35).
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Figure 5-10 Amplification of 1-ng Raji DNA samples sonicated
and then treated with 0, 2, 3, 4, 5, and 6 units of DNase |I.
Effect of Heme compounds have been identified as PCR inhibitors in DNA
Inhibitors —  samples extracted from bloodstains (DeFranchis et al., 1988; Akane
Hematin et al, 1994). It is believed that the inhibitor is co-extracted and co-

purified with the DNA and subsequently interferes with PCR by
inhibiting polymerase activity.

To examine the effects of hematin on the amplification results
obtained by the Sinofiler kit, male DNA 007 (1 ng input) was
amplified with increasing concentrations of hematin: 0 uM, 40 uM,
50 uM, 60 uM, and 70 uM (Figure 5-11 on page 5-36). No
preferential amplification was observed in the presence of increasing
amounts of hematin.
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Figure 5-11 Amplification with the AmpF(STR® Sinofiler™ kit in
the presence of varying concentrations of hematin, analyzed on
the Applied Biosytstems 3130x/ Genetic Analyzer.
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Mixture Studies

SWGDAM  “The ability to obtain reliable results from mixed source samples
Guideline 2.8 should be determined.” (SWGDAM, July 2003)

Evidence samples may contain DNA from more than one individual.
The possibility of multiple contributors should be considered when
interpreting results. Applied Biosystems recommends that individual
laboratories assign a minimum peak height threshold based on
validation experiments performed in each laboratory. This practice
avoids typing when stochastic effects are likely to interfere with
accurate interpretation of mixtures.

Mixture Studies Evidence samples that contain body fluids and/or tissues originating
from more than one individual are an integral component of forensic
casework. Therefore, it is essential to ensure that the DNA typing
system must be able to detect DNA mixtures. Mixed samples can be
distinguished from single-source samples in a variety of ways:

* The presence of greater than two alleles at a locus

» The presence of a peak at a stutter position that is significantly
greater in percentage than what is typically observed in a single-
source sample

+ Significantly imbalanced alleles for a heterozygous genotype
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The peak height ratio is defined as the height of the lower peak (in
RFU) divided by the height of the higher peak (in RFU), expressed as
a percentage. Mean, median, minimum, and maximum peak height
ratios observed for alleles in the AmpF(STR® Sinofiler™ PCR
Amplification Kit loci in unmixed population database samples are
shown inTable 5-3:

Table 5-3 Peak height ratios for 1 ng of input DNA

Number of
Allele Obseli:;ations Mean Median | Minimum | Maximum
CSF1PO 581 88.8 90.4 55.8 99.9
D12S391 688 87.9 89.2 57.4 100
D13S317 590 88.4 89.3 59.5 99.9
D16S539 621 88.6 89.8 52.4 100
D18S51 703 87.6 88.3 575 100
D19S433 637 89.8 90.6 62.6 100
D21S11 689 89.4 90.8 62.3 100
D2S1338 702 87.2 88.8 45.1 99.9
D3S1358 584 90.5 92.0 57.5 99.9
D5S818 575 89.9 91.3 62.0 100
D6S1043 674 90.0 91.5 61.9 100
D7S820 646 88.6 89.9 50.6 100
D8S1179 643 89.8 91.0 58.9 100
FGA 683 88.4 89.7 54.2 100
vWA 664 89.5 91.0 63.9 100
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If an unusually low peak height ratio is observed for one locus, but
there are no other indications that the sample is a mixture, you can
reamplify and reanalyze the sample to determine if the imbalance is
reproducible. Possible causes of imbalance at a locus are:

* Degraded DNA

* Presence of inhibitors

» Extremely low amounts of input DNA

* A SNP in one of the primer binding sites

» Presence of an allele containing a rare sequence that does not
amplify as efficiently as the other allele

Resolution of Genotypes in Mixed Samples

A sample containing DNA from two sources can be comprised (at a
single locus) of any of the seven genotype combinations (see below).

* Heterozygote + heterozygote, no overlapping alleles
(four peaks)

* Heterozygote + heterozygote, one overlapping allele
(three peaks)

» Heterozygote + heterozygote, two overlapping alleles
(two peaks)

* Heterozygote + homozygote, no overlapping alleles
(three peaks)

* Heterozygote + homozygote, overlapping allele (two peaks)
* Homozygote + homozygote, no overlapping alleles (two peaks)
* Homozygote + homozygote, overlapping allele (one peak)

Specific genotype combinations and input DNA ratios of the samples
contained in a mixture determine whether it is possible to resolve the
genotypes of the major and minor component(s) at a single locus.

The ability to obtain and compare quantitative values for different
allele peak heights on Applied Biosystems instruments provides an
additional means to resolve mixed genotypes. The quantitative value
is much less subjective than comparing relative intensities of bands
on a stained gel.

Ultimately, the likelihood that any sample is a mixture must be
determined by the analyst in the context of each particular case,
including the information provided from known reference sample(s).
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Figure 5-12 Amplification of DNA mixtures at various ratios

Limit of Detection of the Minor Component

Mixtures of two DNA samples were examined at various ratios (0:1,
1:1, 3:1, 7:1, 15:1, 1:0). The total amount of genomic input DNA
mixed at each ratio was 1 ng. The samples were amplified in a
GeneAmp® PCR System 9700, then electrophoresed and detected
using an Applied Biosystems 3130x/ Genetic analyzer.

The results of the mixed DNA samples are shown in Figure 5-12,
where samples A and B were mixed according to the indicated ratios.
The minor component allele calls at non-overlapping loci are
highlighted. The amplification of the minor contributor at 3:1 and 7:1
(0.875:0.125 ng) mixture ratios was readily typeable. 15:1 ratios
generally resulted in partial profiles for the minor component.
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Table 5-4 shows the profiles of the samples in Figure 5-12 on
page 5-40.

Table 5-4 Genotypes of mixed DNA samples

Allele (ggﬂrilsgﬁ‘)\olgo?) Profile Sample B
D8S1179 12,13 14,15
D21511 28, 31 28, 30
D75820 7,12 8,9
CSF1PO 11,12 10
D351358 15,16 15,18
D5S818 11 8, 11
D138317 11 12,14
D16S539 9,10 12,13
D251338 20, 23 20, 21
D195433 14,15 12.2,14.2
VWA 14,16 14
D125391 18,19 18, 24
D18S51 12,15 17,19
Amelogenin X, Y X, Y
D6S1043 12,14 11,12
FGA 24, 26 21, 22

The Sinofiler kit has been optimized to reliably amplify and type
approximately 0.50 to 1.25 ng of single-source DNA.
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Population Data

SWGDAM
Guideline 2.7

Overview

“The distribution of genetic markers in populations should be
determined in relevant population groups.” (SWGDAM, July 2003)

To interpret the significance of a match between genetically typed
samples, you must know the population distribution of alleles at each
locus in question. If the genotype of the relevant evidence sample is
different from the genotype of a suspects reference sample, then the
suspect is excluded as the donor of the biological evidence that was
tested. An exclusion is independent of the frequency of the two
genotypes in the population.

If the suspect and evidence samples have the same genotype, then the
suspect is included as a possible source of the evidence sample. The
probability that another, unrelated individual would also match the
evidence sample is estimated by the frequency of that genotype in the
relevant population(s).

Population Samples Used in These Studies

The AmpF{STR Sinofiler PCR Amplification Kit was used to
generate the population data provided in this section. Samples were
collected from individuals throughout the United States with no
geographical preference.

Analysis across the three databases of 2,034 total chromosomes per
locus revealed the following number of different alleles: 8 CSF1PO
alleles, 14 D2S1338 alleles, 12 D3S1358 alleles, 9 D5S818 alleles,
25 D6S1043 alleles, 12 D7S820 alleles, 11 D8S1179 alleles, 21
D12S391 alleles, 10 D13S317 alleles, 8 D16S539 alleles, 23 D18S51
alleles, 19 D19S433 alleles, 24 D21S11 alleles, 28 FGA alleles, and
12 vWA alleles.

Conformity of the observed genotype frequencies with Hardy-
Weinberg expectations (HWE) was examined in each sample
population by the exact test using the HW-QuickCheck software
(Bonferroni, 1936; Guo and Thompson, 1992, Kalinowski, 2006). A
p-value >0.05 was obtained for all STRs, except D6S1043 in
African-American, D3S1358 in Asian, D19S433 in Caucasian, and
D12S391 in Hispanic samples. Considering the Bonferroni procedure
and the fact that 15 tests for HWE were simultaneously performed on
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the same population sample, the significance threshold is adjusted
from 0.05 to 0.05/15 = 0.0033, which is clearly below the p-values
observed in these loci. Hence, the departures from HWE were not
significant.

In addition to the alleles that were observed and recorded in the
Applied Biosystems databases, other known alleles have been
published or reported to Applied Biosystems by other laboratories
(see the STRBase at http://www.cstl.nist.gov/div831/strbase).

AmpF(STR®  Table 5-5 shows the AmpF(STR® Sinofiler™ kit allele frequencies in
Sinofiler™ Kit four populations, listed as percentages.
Allele o .
Frequencies Table 5-5 AmpF(STR Sinofiler kit allele frequencies
African- . . . .
Alele | American | (", | SCCE | tem
CSF1PO
6 t f t t
7 5.56 0.68% * 0.95%
8 6.98 0.45% 0.37% 0.71%
9 4.44 4.32 2.21 2.37
10 24.44 22.95 29.04 23.70
11 23.65 25.91 29.60 30.81
12 27.30 37.73 29.96 36.97
13 6.83 6.82 7.90 3.55
14 0.79 0.68% 0.92 0.95%
15 ¥ ¥ ¥ ¥
p-value 0.07 0.19 0.35 0.18
D12S391
13 * * * 0.24%
14 ¥ ¥ ¥ ks
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

African-

Allele American Asian Caucasian Hispanic
(n=315) (n=219) (n=272) (n=211)
15 6.03 0.68% 4.60 4.74
16 6.51 0.45% 2.39 5.92
17 15.87 5.91 10.11 5.92
171 0.32% * ¥ *
17.3 0.48% * 2.21 1.42
18 25.71 24.55 15.62 17.54
18.3 0.95 0.45% 2.02 1.90
19 16.98 18.18 10.66 18.25
19.1 0.63% * ¥ *
19.3 0.16% * 0.55% 2.84
20 10.95 17.5 12.32 13.51
20.3 * 0.23% 0.37% 0.24%
21 6.83 10.68 13.05 10.66
22 3.33 9.32 13.42 9.24
23 2.06 5.91 8.46 3.55
24 1.90 3.18 2.76 1.18
25 1.11 1.59 0.92 1.90
26 0.16% 0.23% 0.55% 0.71%
27 * 0.45% * 0.24%
28 * 0.23% * *
p-value 0.45 0.20 0.37 0.02878§
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

Allele AAI:"Z(;;';'“ Asian Caucasian Hispanic
= 315) (n =219) (n =272) (n =211)
D13S317

6 * 0.23% * *
7 * 0.23% * +
8 3.81 29.32 9.74 8.77
9 1.59 11.82 5.70 14.93
10 3.02 15.91 7.35 9.24
11 30.48 22.73 29.78 2417
12 44.92 14.55 30.70 27.49
13 11.90 4.09 11.76 10.43
14 3.97 0.45% 4.96 4.98
15 0.32% 0.23% * *

p-value 0.38 0.20 0.23 0.19

D16S539
5 ¥ b ¥ S
8 3.65 0.45% 1.10 2.37
9 20.48 27.27 12.32 11.37
10 10.79 17.27 4.96 14.22
11 30.79 24.77 32.35 30.09
12 17.14 19.77 28.49 26.54
13 15.56 9.32 19.12 14.45
14 1.59 0.68* 1.47 0.95%
15 * + 0.18% *
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

African-

Allele American Asian Caucasian Hispanic
(n=315) (n=219) (n=272) (n=211)
p-value 0.06 0.45 0.13 0.40
D18S51
7 ¥ ¥ ¥ ¥
9 ¥ * ¥ 0.24%
10 0.16% * 1.10 0.24%
10.2 0.16% * ¥ *
11 0.48% 1.14 0.74% 0.71%
12 5.40 5.91 14.52 9.00
12.2 * * 0.18% *
13 4.60 15 13.05 15.17
13.2 0.79 * ¥ *
14 6.67 18.18 16.36 13.03
14.2 0.32% * ¥ *
15 18.73 22.95 11.40 10.90
15.2 * * * 0.24%
16 16.83 14.55 14.15 15.40
17 15.71 7.27 12.13 15.40
18 11.43 4.09 9.01 8.77
19 9.52 2.73 4.41 3.79
20 5.24 2.05 1.47 2.13
21 3.02 2.73 0.55% 2.61
22 0.79 1.82 0.18* 0.95%
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

Allele AAI:"Z(;;';'“ Asian Caucasian Hispanic
" = 315) (n=219) (n=272) (n=211)
23 0.16* 0.68* 0.55% 0.95%
24 * 0.45% * 0.24%
25 * * 0.18% *
26 t ¥ ¥ ¥
27 * * * 0.24%
p-value 0.37 0.55 0.39 0.41
D19S433
9 * 0.23% * *

10 0.95 * * 0.24%
11 8.57 * 0.18% 1.18
11.2 0.16% * * 0.24%
12 11.43 3.86 8.64 7.1

121 * * 0.18* *
12.2 4.60 0.91% * 1.18
13 26.67 32.05 26.10 23.22
13.2 4.92 3.64 1.10 5.69
14 20.79 21.14 33.64 25.83
14.2 4.92 12.05 2.76 5.69
15 6.51 5.45 16.91 14.45
16.2 4.76 16.14 2.21 9.24
16 1.75 1.36 6.62 3.08
16.2 3.33 2.73 1.10 213
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

Allele AAI:"Z(;;';'“ Asian Caucasian Hispanic
(n=315) (n=219) (n=272) (n=211)
17 * * 0.18% 0.24%
17.2 0.63% * ¥ 0.47%
18 * * 0.18% *
18.2 ¥ * 0.18% *
p-value 0.32 0.09 0.00918 0.37
D21S11
24 ¥ ¥ ¥ ¥
24.2 ¥ * ¥ 0.24%
25 ¥ ¥ ¥ ¥
26 0.32% * 0.55% 0.47%
27 3.81 0.45% 2.94 2.61
28 24.29 4.55 15.81 11.14
28.2 * 0.68% * 0.24%
29 16.19 26.59 24.26 17.77
29.2 * 0.23% * 0.24%
29.3 0.16% * 0.18* *
30 19.37 29.32 23.53 30.33
30.2 2.06 1.14 3.68 1.42
30.3 ¥ 0.68* ¥ *
31 9.84 9.77 5.51 5.92
31.2 6.19 7.73 9.19 10.43
32 2.06 3.41 1.65 0.71%
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)
Allele Ap":g(:iac':n Asian Caucasian Hispanic
(n = 315) (n=219) (n=272) (n=211)
32.2 6.98 9.77 9.56 13.51
33 0.79 1.36 0.18% 0.24%
33.1 0.16% * * *
33.2 3.81 2.73 2.39 3.55
34 0.32% * * *
34.1 ¥ 0.23% ¥ *
34.2 0.16% 0.91% 0.37% 0.71%
35 2.54 * ¥ 0.47%
35.2 t ¥ ¥ ¥
36 0.79 * 0.18* *
37 ¥ t ¥ ¥
38 0.16% * * *
p-value 0.20 0.16 0.13 0.41
D2S1338
<14 0.16% * 0.18% *
15 0.63% * 0.18* *
16 4.6 1.82 4.60 3.08
17 10.16 8.86 18.75 19.43
18 4.76 10.68 8.27 6.87
19 16.98 19.09 13.97 16.35
20 11.9 12.05 15.26 13.74
21 14.29 3.18 2.39 1.90
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

African-

Allele American Asian Caucasian Hispanic
(n=315) (n=219) (n=272) (n=211)
22 11.75 5.68 2.76 6.64
23 7.46 16.14 9.01 14.93
24 8.1 15.23 12.13 8.53
25 6.19 5.91 10.66 6.64
26 2.54 0.91% 1.65 1.66
27 0.48% * 0.37% 0.24%
28 t ¥ ¥ ¥
p-value 0.37 0.33 0.37 0.42
D3S1358

9 0.48% * * 0.24%
11 0.16% * 0.18% *
12 0.16% 0.23% * 0.24%
13 0.95 * * 0.47%
14 9.05 4.32 15.99 10.43
15 31.43 34.77 25.37 35.78

15.2 0.16% * * *
16 27.62 31.82 25.92 26.07
17 22.54 20.91 17.46 16.35
18 6.98 7.05 13.42 9.95
19 0.48% 0.23% 1.47 0.47%
20 * 0.23% 0.18% *

p-value 0.08 0.00643 0.27 0.42
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Population Data

Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

Allele AAI:"Z(;;';'“ Asian Caucasian Hispanic
" = 315) (n=219) (n=272) (n=211)
D55818

7 0.32% 3.41 0.18* 4.98
8 4.92 * 0.74% 0.47+
9 1.27 7.05 4.78 3.08
10 7.46 20.23 4.96 4.27
11 25.08 30.91 36.40 38.15
12 34.76 22.95 33.82 31.75
13 23.97 14.09 17.83 16.35
14 1.43 0.68* 0.92 0.71%
15 0.79 0.23% 0.37% 0.24%
16 t ¥ ¥ ¥

p-value 0.16 0.39 0.37 0.15

D6S1043
<8 * + 0.18% *
9 0.16% * * *
10 1.59 2.73 1.65 1.90
11 10.48 11.36 26.47 16.35
12 22.54 13.86 27.94 20.38
13 9.68 11.14 6.80 12.32
14 5.71 16.36 4.96 12.56
15 5.56 1.82 1.10 2.61
16 3.65 0.23% 0.92 0.24%
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

African-

Allele American Asian Caucasian Hispanic
(n=315) (n=219) (n=272) (n=211)
17 7.62 2.27 6.43 6.40
18 11.75 19.55 7.90 9.00
18.2 * 0.23% ¥ *
19 13.65 13.18 9.74 7.58
19.3 0.16* * ¥ *
20 5.71 5.45 5.15 2.37
20.3 * * * 1.42
21 0.32% 1.36 0.55% 0.47%
21.3 0.32% * 0.18% 4.74
22 t ¥ t ¥
22.3 0.16% * * 0.71%
23 0.48% * * 0.24%
23.3 * * * 0.47%
24 0.16% * * *
24.3 * * * 0.24%
25 0.32% * * *
p-value 0.04168 0.22 0.33 0.06
D7S820
6 0.16% * * *
7 0.79 0.23% 1.29 1.42
8 19.05 13.64 18.01 13.27
9 10.63 5.45 14.34 8.77
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

Allele AAI:"Z(;;';'“ Asian Caucasian Hispanic
" = 315) (n=219) (n=272) (n=211)
10 32.38 18.41 28.12 27.96
10.2 * 0.23% * *
11 21.90 36.14 21.51 23.46
11.3 * * * 0.24%
12 12.70 22.73 13.24 19.19
13 2.06 1.82 2.76 4.74
14 0.32% 0.68% 0.55% 0.95%
15 * 0.23% 0.18* *
p-value 0.53 0.23 0.18 0.37
D8S1179
8 0.16* * 1.65 0.95%
9 0.48% 0.23% 1.65 0.47+
10 1.90 11.82 8.09 8.06
11 3.81 11.14 7.72 6.64
12 11.27 12.5 15.62 7.82
13 19.52 20.68 31.99 29.62
14 34.13 17.73 19.30 28.67
15 20.79 14.55 10.66 13.74
16 6.98 8.86 3.12 3.55
17 0.95 1.82 0.18% 0.47+
18 * 0.23% ¥ *
19 t ¥ t ¥
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

Allele AAI:"Z(;;';'“ Asian Caucasian Hispanic
(n=315) (n=219) (n=272) (n=211)
p-value 0.41 0.27 0.35 0.11
FGA
17 0.32% 0.45% ¥ *
17.2 0.16% * ¥ *
18 0.79 2.27 1.47 0.24%
18.2 1.59 * ¥ *
19 6.67 6.36 5.88 6.64
19.2 0.79 * ¥ *
20 6.03 7.27 14.71 9.95
20.2 0.63% * 0.37% 0.24%
21 10.63 11.82 19.85 15.17
21.2 * 0.68% 0.18* *
22 19.52 17.05 17.83 12.09
22.2 0.16% 1.14 0.55% 0.47%
23 17.30 23.41 15.07 14.22
23.2 * 0.91% 0.18* *
24 16.98 17.05 15.26 17.06
24.2 * 0.68% * *
25 9.05 7.05 6.80 14.45
25.2 * 0.23% * *
26 4.29 1.82 1.10 5.69
26.2 * 0.45% * *
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Population Data

Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

Allele Ap":g(:iacr:n Asian Caucasian Hispanic
(n = 315) (n=219) (n=272) (n=211)

27 2.86 0.68% 0.55% 2.84

28 0.95 0.23% 0.18% 0.71%

29 0.32% * * 0.24%
30 0.16* * ¥ *
30.2 0.16% * * *
31.2 0.32% * ¥ *
322 t ¥ ¥ ¥
33.2 t ¥ ¥ ¥
34.2 0.16% * * *
42 .2 t ¥ t ¥
43.2 t ¥ ¥ ¥
44.2 * * * *
45.2 * * * *
46.2 0.16% * * *
47.2 * * * *
48.2 * * * *
50.2 * * * *
51.2 * * * *

p-value 0.26 0.38 0.31 0.24

VWA
11 0.48% * * 0.24%
12 0.32 * * 0.24%
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Table 5-5 AmpF/(STR Sinofiler kit allele frequencies (continued)

Allele AAII:Z(;;':n Asian Caucasian Hispanic
(n = 315) (n=219) (n=272) (n=211)
13 1.27 * 0.37% *
14 7.14 24.09 8.27 6.87
15 20.48 2.73 12.87 13.74
16 23.97 17.27 20.04 27.73
17 20.32 23.64 25.92 27.73
18 15.87 19.77 20.04 16.11
19 6.83 10.68 10.11 6.16
20 2.70 1.36 2.39 1.18
21 0.48% * * *
22 t ¥ t ¥
23 0.16% * * *
24 ¥ b ¥ b
p-value 0.16% 0.44 0.54 0.11

I A minimum allele frequency (0.79% for the African-American database,
1.14% for the Asian database, 0.92% for the U.S. Caucasian database,
and 1.18% for the U.S. Hispanic database) is suggested by the National
Research Council in forensic calculations.

§ p-value <0.05 for exact test for HWE

Low-Frequency Alleles

Some alleles of the Sinofiler kit loci occur at a low frequency. For
these alleles, a minimum frequency (five divided by 2n, where n
equals the number of individuals in the database) was assigned for
the Sinofiler kit African-American, Asian, U.S. Caucasian, and U.S.
Hispanic databases, as suggested in the 1996 report of the Committee
on DNA Forensic Science (National Research Council, 1996). These
databases are summarized in Table 5-6 on page 5-59. The minimum
reportable genotype frequency at each locus is: 1.42 X 10~ for the
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African-American database; 2.43 X 10~ for the Asian database; 1.76
X 107 for the U.S. Caucasian database; and 2.57 X 10~ for the U.S.
Hispanic database [p? + p(1-p) 8, where 8 = 0.01]. Hence, the
minimum combined multilocus genotype frequency at 15 loci is:
1.87 X 10758 for the African-American database; 6.15 X 107> for the
Asian database; 4.63 X 1077 for the U.S. Caucasian database; and
1.45 X 107>* for the U.S. Hispanic database.

Concordance Applied Biosystems analyzed 300 samples by comparing allele calls
Studies between the AmpF(STR® Sinofiler™ and AmpF(STR® Identifiler®
kits. The genotype data from all the analyzed samples were
concordant between the Identifiler and Sinofiler kits.
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Mutation Rate

Estimation of spontaneous or induced germline mutation at genetic
loci can be achieved by comparing the genotypes of offspring to
those of their parents. From such comparisons the number of
observed mutations are counted directly.

In previous studies, genotypes of ten STR loci that were amplified by
the AmpF(STR® SGM Plus® PCR Amplification Kit were
determined for a total of 146 parent-offspring allelic transfers
(meioses) at the Forensic Science Service, Birmingham, England.
One length-based STR mutation was observed at the D18S11 locus;
mutations were not detected at any of the other nine STR loci. The
D18S11 mutation was represented by an increase of one 4-nt repeat
unit, allele 17 was inherited as allele 18 (single-step mutation). The
maternal/paternal source of this mutation could not be distinguished.

Additional Mutation Studies

Additional studies (Edwards et al., 1991; Edwards et al., 1992;
Weber and Wong, 1993; Hammond ef al., 1994; Brinkmann et al.,
1995; Chakraborty et al., 1996; Chakraborty et al., 1997; Brinkmann
et al., 1998; Momhinweg et al., 1998; Szibor et al., 1998) of direct
mutation rate counts produced:

+ Larger sample sizes for some of the AmpF{STR® Sinofiler™
PCR Amplification Kit loci.

* Methods for modifications of these mutation rates (to infer
mutation rates indirectly for those loci where the rates are not
large enough to be measured directly and/or to account for those
events undetectable as Mendelian errors).
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Probability of Identity

Table 5-6 shows the Probability of Identity (PI) values of the
AmpF(STR® Sinofiler™ PCR Amplification Kit loci individually and

combined.

Table 5-6 Probability of Identity values for the AmpF(STR®
Sinofiler™ kit STR loci

Locus :‘r::ﬁei;:ie::r;-n Asian Caucasian Hispanic
CSF1PO 0.074 0.119 0.127 0.142
D12S391 0.041 0.046 0.025 0.026
D13S317 0.145 0.069 0.077 0.059
D16S539 0.070 0.082 0.101 0.084
D18S51 0.030 0.039 0.031 0.029
D19S433 0.037 0.067 0.081 0.049
D21S11 0.040 0.07 0.052 0.049
D251338 0.024 0.034 0.030 0.038
D3S1358 0.099 0.145 0.073 0.093
D5S818 0.101 0.083 0.140 0.122
D6S1043 0.028 0.034 0.057 0.029
D7S820 0.084 0.092 0.071 0.075
D8S1179 0.081 0.043 0.063 0.071
FGA 0.031 0.038 0.042 0.033
vWA 0.057 0.071 0.059 0.081
Combined 1.12x 107" | 8.37x 1070 | 6.28 x 10" | 2.31x 10719
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The P, value is the probability that two individuals selected at random
will have an identical Sinofiler kit genotype (Sensabaugh, 1982). The
P values for the populations described in this section are then
approximately 1/8.93 X 10'® (African-American), 1/1.19 X 10'8
(Asian), 1/1.59 X 10'¥ (U.S. Caucasian), and 1/4.33 X 10'®

(U.S. Hispanic).
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Probability of Paternity Exclusion

Table 5-7 shows the Probability of Paternity Exclusion (Py) values of
the AmpF(STR® Sinofiler™ PCR Amplification Kit STR loci
individually and combined.

Table 5-7 Probability of Paternity Exclusion values for the
AmpF(STR® Sinofiler™ kit

Locus AAn]:(:ﬁ:;n Asian Caucasian Hispanic
CSF1PO 0.530 0.433 0.461 0.402
D12S391 0.696 0.649 0.767 0.682
D13S317 0.397 0.556 0.535 0.583
D16S539 0.530 0.564 0.581 0.558

D18S51 0.766 0.712 0.737 0.748
D195433 0.678 0.676 0.461 0.655
D21S11 0.741 0.676 0.723 0.673
D2S1338 0.766 0.767 0.737 0.758
D3S1358 0.471 0.597 0.561 0.381
D55818 0.471 0.589 0.473 0.416
D6S1043 0.690 0.694 0.665 0.682
D75820 0.570 0.492 0.650 0.627
D8S1179 0.581 0.739 0.602 0.655
FGA 0.715 0.694 0.679 0.710
VWA 0.672 0.597 0.636 0.655
Combined | 0.99999973 | 0.999999774 | 0.99999968 | 0.99999964
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The Py, value is the probability, averaged over all possible mother-
child pairs, that a random alleged father will be excluded from
paternity after DNA typing of the Sinofiler kit STR loci
(Chakraborty et al., 1996).
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Troubleshooting

In This Appendix Follow the actions recommended in this appendix to troubleshoot
problems that occur during analysis.

Troubleshooting. .. ......... .. .. .. .. .. A-2

AmpF&TR® Sinofiler™ PCR Amplification Kit User Guide A-1



Appendix A Troubleshooting

Troubleshooting

Table A-1

Troubleshooting

Observation

Possible Causes

Recommended Actions

Faint or no signal from
both the AmpF(STR®
Control DNA 9947A
and the DNA test
samples at all loci

Incorrect volume or absence of
AmpF(STR® PCR Reaction Mix,
AmpF(STR® Sinofiler™ Primer Set,
or AmpliTag Gold® DNA
Polymerase.

Repeat amplification.

No activation of AmpliTaq Gold
DNA Polymerase

Repeat amplification, making sure to
hold reactions initially at 95 °C for
11 min.

Master Mix not vortexed thoroughly
before aliquoting

Vortex the Master Mix thoroughly.

AmpF(STR® Sinofiler™ Primer Set
exposed to too much light

Store the Primer Set protected from
light.

GeneAmp® PCR System
malfunction

Refer to the thermal cycler user’s
manual and check instrument
calibration.

Incorrect thermal cycler
parameters

Check the protocol for correct
thermal cycler parameters.

Tubes not seated tightly in the
thermal cycler during amplification

Push reaction tubes firmly into
contact with block after first cycle.
Repeat test.

GeneAmp PCR System 9600
heated cover misaligned

Align the GeneAmp 9600 heated
cover properly so that white stripes
align after twisting the top portion
clockwise.

Wrong PCR reaction tube

Use Applied Biosystems MicroAmp
Reaction Tubes with Caps for the
GeneAmp 9600 and 9700.

MicroAmp™ Base used with
tray/retainer set and tubes in
GeneAmp® 9600 and 9700

Remove MicroAmp Base from
tray/retainer set and repeat test.

A-2
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Troubleshooting

Table A-1 Troubleshooting (continued)

Observation

Possible Causes

Recommended Actions

Faint or no signal from
both the AmpF(STR®
Control DNA 9947A
and the DNA test
samples at all loci.
(continued)

Insufficient PCR product
electrokinetically injected

For ABI PriIsM® 3100/3100-Avant or
3130/3130x/ instrument runs:

Mix 1.0 pL of PCR product and 9 puL
of Hi-Di™ Formamide/GeneScan™
500 LIZ® solution.

AWARNING CHEMICAL

HAZARD. Formamide causes eye,
skin, and respiratory tract irritation.
It is a possible reproductive and
birth defect hazard. Read the
MSDS, and follow the handling
instructions. Wear appropriate
protective eyewear, clothing, and
gloves.

Degraded formamide

Check the storage of formamide; do
not thaw and refreeze multiple
times. Try Hi-Di™ Formamide.

AWARNlNG CHEMICAL

HAZARD. Formamide causes eye,
skin, and respiratory tract irritation.
It is a possible reproductive and
birth defect hazard. Read the
MSDS, and follow the handling
instructions. Wear appropriate
protective eyewear, clothing, and
gloves.
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Table A-1

Troubleshooting (continued)

Observation

Possible Causes

Recommended Actions

Positive signal from
AmpF(STR® Control
DNA 9947A but partial
or no signal from DNA
test samples

Quantity of test DNA sample is
below assay sensitivity

Quantitate DNA and add 0.5 to
1.25 ng of DNA. Repeat test.

Test sample contains PCR inhibitor
(for example, heme compounds,
certain dyes)

Quantitate DNA and add minimum
necessary volume. Repeat test.

Wash the sample in a
Centricon®-100. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of
DNA sample by running an agarose
gel. If DNA is degraded, reamplify
with an increased amount of DNA.

Dilution of test sample DNA in H,O
or wrong buffer (e.g., wrong EDTA
concentration)

Redilute DNA using TE Buffer (with
0.1 mM EDTA).

More than one allele
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid
introducing foreign DNA during
laboratory handling.

Too much DNA in reaction

Use recommended amount of
template DNA (0.5 to 1.25 ng).

Mixed sample

Amplification of stutter product
(n-4 nt position)

See “Stutter Products” on
page 5-18

Incomplete 3" A base addition
(n-1 nt position)

See “Addition of 3" A Nucleotide” on
page 5-283. Be sure to include the
final extension step of 60 °C for

60 min in the PCR.

Signal exceeds dynamic range of
instrument (off-scale data)

Quantitate DNA and reamplify
sample, adding 0.5 to 1.25 ng of
DNA.

Poor spectral separation
(bad matrix)

Follow the steps for creating a
matrix file.

Confirm that Filter Set G5 modules
are installed and used for analysis.

A-4
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Table A-1 Troubleshooting (continued)

Observation

Possible Causes

Recommended Actions

Some but not all loci
visible on
electropherogram

Test sample DNA is severely
degraded

If possible, evaluate the quality of
DNA sample by running an agarose
gel. If DNA is degraded, reamplify
with an increased amount of DNA.

Test sample contains high
concentrations of a PCR inhibitor
(for example, heme compounds,
certain dyes)

Quantitate DNA, then add minimum
necessary volume. Repeat test.

Wash the sample in a
Centricon-100.
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